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FOREWORD

v

In today’s rapidly evolving world, the role of skilled craftsmen and women is more crucial than 
ever. The Craft Instructor Training Scheme (CITS) stands at the forefront of this transformation, 
shaping the educators who will train the next generation of artisans and technicians. This book 
aims to provide an in-depth understanding of the subject, exploring its significance, 
methodologies, and impact on vocational training.

The Craft Instructor Training Scheme was established with the objective of enhancing the 
quality of instruction in industrial training institutes and other vocational training institutions. By 
equipping instructors with advanced skills and knowledge, the scheme ensures that they are 
well-prepared to impart high-quality training to their students. This, in turn, contributes to the 
creation of a highly skilled workforce capable of meeting the demands of modern industry.

The initial chapters provide the importance of specialized instructor training. Following this, 
detailed chapters delve into the curriculum covering advanced techniques, safety protocols, 
and instructional strategies. Each section is designed to offer both theoretical insights and 
practical applications, ensuring a well-rounded understanding of the subject.

The book offers recommendations for overcoming obstacles and enhancing the effectiveness 
of the program, with the ultimate goal of producing highly skilled  instructors capable of shaping 
the future workforce.

This book is intended for a diverse audience, including current and aspiring  instructors, 
vocational training administrators, policymakers, and industry stakeholders. It serves as a 
valuable resource for understanding the intricacies of the subject and its pivotal role in 
vocational education.

I extend my heartfelt gratitude to all contributors who have shared their experiences and 
expertise, enriching this book with their valuable insights. Special thanks to the contribution of 
the development team, reviewers and NIMI that have supported this endeavor, providing 
essential data and resources.

It is my sincere hope that this book will inspire and guide readers in their efforts to enhance 
vocational training, ultimately contributing to the development of a skilled and competent 
workforce.

Foreword

ATUL KUMAR TIWARI, I.A.S.
Secretary, MSDE

ATUL KUMAR TIWARI, I.A.S.
Secretary

अतुल कुमार ितवारी, I.A.S.

सिचव GOVERNMENT OF INDIA
MINISTRY OF SKILL DEVELOPMENT 

AND ENTREPRENEURSHIP
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The Craft Instructor Training Scheme is an indispensable module of the Craftsmen 
Training Scheme, which has been an integral part of the Indian skill development 
industry since its inception. This program aims to equip instructors with the necessary 
skills and teaching methodology to effectively transfer hands-on skills to trainees and 
promote a holistic learning experience. The first Craft Instructor Training Institute 
was established in 1948, followed by six more institutes across India in 1960. Today, 
these institutes, including the National Skill Training Institute (formerly Central Training 
Institute for Instructors), offer the CITS course, which is mandated by the Directorate 
General of Training (DGT).

The Craft Instructor training program is designed to develop skilled manpower 
for industries. The course aims to offer instructors an opportunity to improve their 
instructional skills, engage learners effectively, offer impactful mentoring, and make 
efficient use of resources, leading to a more skilled workforce in various industries. The 
program emphasizes collaborative and innovative approaches to teaching, resulting in 
high-quality course delivery. Overall, the Craft Instructor Training Scheme is a pivotal 
program that helps instructors grow in their careers and make a significant contribution 
to society. This program is essential for developing skilled manpower and promoting a 
robust learning environment that benefits both trainees and instructors alike.

PREFACE

vi
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ABOUT THE TEXT BOOK

The Vocational Instructor Training Program is a comprehensive initiative designed to equip 
aspiring students with the necessary skills and knowledge to effectively teach in vocational 
education settings. This program encompasses a range of pedagogical strategies, instructional 
techniques, and subject-specific content tailored to the diverse vocational fields. Participants 
engage in coursework that covers curriculum development, assessment methods, classroom 
management, and the integration of industry-relevant technologies. Practical experience and 
hands-on training are emphasized, allowing participants to apply theoretical concepts in real-
world teaching environments. Through collaborative learning experiences and mentorship 
opportunities, aspiring vocational instructors develop the confidence and competence to 
facilitate engaging and impactful learning experiences for their students. This training program 
aims to cultivate a new generation of educators who are not only proficient in their respective 
vocational fields but also adept at fostering the success and employability of their students in 
today’s competitive workforce.

This text book covers communication, self-management, information and communication 
technology, entrepreneurial and green skills. It has been developed as per the learning 
outcome-based curriculum. 

									         G C Rama Murthy,
									         Joint Director,
									         Curriculum Development, DGT,
									         MSDE, New Delhi.
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SEWING TECHNOLOGY - CITS

Objectives

EXERCISE 1 & 2 : Practice of Drafting

At the end of this exercise you shall be able to:
•	 practice of drafting.

MODULE 1 : Concept of Drafting, Pattern Making,      	
			   Grading, Draping & Stitching

Tools/Instruments
•	  Measurement	 - 1 No.
•	  Brown paper	 - 8 Nos. 
•	  Pencil/eraser/scale	 - 1 No each. 
•	  Measurement tape	 - 1 No. 

Requirements

Procedure
	 TASK 1: Preparation for measuring

1	 For taking the measurements use a good quality of measuring tape which study and will not stretch. It should 
not be too stiff. It should be flexible.

2	 The metal end of the tape were been used for vertical, horizontal and also in circumference measurements.

3	 The measurements should be taken over the smooth fitting foundation garments and never over bulky 
garments.

4	 Before taking measurements tie a cord or string around the waist.

5	 Take a ¼” wide tape and cord it around the armhole. This will make it easier to measure the width of shoulder, 
armhole, depth, etc..

6	 Stand correct with the arm hanging straight at the sides while measurements are being made by someone 
else. It is possible though less convenient and less accurate to take your own measurements.

7	 Take snug measurements rather than tight or loose ones.

8	 Hold the tape parallel to the floor for horizontal measurements and the tape down to the floor for the vertical 
measurements.

9	 As the measurements are taken, record then in a notebook. The measurements will depend on the type and 
style of garments. You are making and the age and sex of the intended user.

TASK 2: Measurements needed for the construction of the garments for ladies
Bodies measurements
1	 Bust:  Measurements around the fullest part of the bust raising the measuring tape slightly to a level just below 

the shoulder blades at the back.

2	 Waist: Measurements snugly around the waist where you tied the cord, keeping the tape parallel to the floor.

3	 Neck: Measure around the neck, passing the tape just above the color bone in front and along the base of the 
neck at the back.

•	  Marking chalk	 - 5 Nos. 	
•	  French curve set	 - 1 Set. 	

© NIMI 
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SEWING TECHNOLOGY - CITS

4	 Shoulder: Measure from the neck joint to the arm joint along the shoulder [A to B in Fig 1 (a)] otherwise you 
can measure from pit to pit of the arm joint.

5	 Front waist length: Measure down from neck at the highest point of shoulder to waist line through the fullest 
part of the bust [A to C in Fig 1 (a)]

6	 Shoulder to bust: Measure down from the highest point of the shoulder to the tip of the bust [A to D in  
Fig 1 (a)]

7	 Distance between bust points: Measure in horizontal direction the distance between two bust points. [D to 
E in Fig 1(a)]

8	 Back width or across back measurements: Measure across the back from armhole to armhole about 3” 
below base of the neck. [P to Q in Fig 1(b)]

9	 Back waist length: Measure from the base of neck to the centre back to the waist line. [R to S in Fig 1(b)]

10	Armhole depth: Measure from the base of neck at center back to a point directly below it and in level with the 
bottom of the arm where it joints the body. [R to T in Fig 1(b)]

	 Note: Shoulder to bust and Distance between bust points measurements are needed for location 
and the position of darts.

Sleeve measurements
Upper arm circumference: Measure around fullest part of the arm.

Lower arm circumference: Measure around the arm at decided level corresponding to lower edge of sleeve.

Elbow circumference: Measure around the arm at elbow.

Wrist: Measure around the wrist.

Sleeve length: For short sleeve length measure down from the tip of shoulder at the top of arm to desired length 
of sleeve. [B to F in Fig 1(a)]

For elbow length sleeve: Measure from the top of arm to elbow [B to G in Fig 1(a)] sleeve measure for full length 
bend the elbow slightly and measure down from top of arm to back of wrist passing the tape over the elbow point. 
[B to H in Fig 1(a)]

CITS : Apparel - Sewing Technology  - Exercise 1&2 

Fig 1(a) Fig 1(b)
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SEWING TECHNOLOGY - CITS

TASK 3: Drafting of women’s bodice block
Measurements 	 size-8

Round bust – 93 cms

Round waist -72cms

Bodice length – 47.5cms

Apex point – 27.5cms

Drafting steps
1	 Construct the block ABCD, AB is the length of bodice + 2 cm & AC is ½ Round Bust+2.5 cm.

2	 Divide the block into 6 equal division along AC. Mark them XYZ & XY.

3	 Now divide the length into half at EF. GH divides AE FC into half & I J divides AG HC into half and KL divides 
AIJC into half.

4	 Mark AZZ B as BACK & CZZ D as FRONT.

5	 Since the front bodice requires extra provision. The front should be made bigger than back. Therefore shift the 
side seam line zz1=1 cm towards the back.

6	 Neckline; from x go in 1 cm towards AE from X 1CM towards C. This is the highest shoulder point. Construct 
two necklines from X to K for back & X to H for front.

7	 Shoulder; DRAW a straight line for shoulder from X passing through Y and extended by 2.5 cm from Y1 to k1. 
Similarly from shoulder drop is made from X passing through Y1-E extended by 2.5 from Y1 to L1.

8	 Armhole; From G measure 1.5 cm towards H1 mark it G1. From H measure 0.5 cm towards G mark it H1. 
Starting from the lowest shoulder point k1. Mark a smooth curve passing through G1& touching O. Repeat the 
same for other armhole.

9	 Side seam; Locate the bust from the highest shoulder point. Draw a line through the block for bust level. Mark 
2.5 cm on each side of ZZ1 line at the respective waist level B1 D1. Shape for waist at the side seam from bust 
level to B1 & bust level to D1.

At the bust level locate the bust point P 1cm a way from line X & X (1) towards Y drop a perpendicular line on 
waist line at Q. 

PQ is the dart line for the waist dart starting from the armpit point O mark R

OR=10 cm, join RP in a straight line for side seam dart line mark 1 cm above & below R the dart line complete 
the dart legs to end the dart 2-5 cm a way from the point P for waist dart mark 2 cm on eiher side of waist dart line 
complete the dart to an end 1 cm a way from the 6ust point .The back waist dart is constructed  on the division 
line X X(1), it is 2 cm wide & ends at the bust level.

CITS : Apparel - Sewing Technology  - Exercise 1&2 CITS : Apparel - Sewing Technology  - Exercise 1&2

Fig 1
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SEWING TECHNOLOGY - CITS

TASK 4: Drafting  of women skirt block
Measurements 	

size-8cms

Waist-63.5cms

Hips-92cms

Waist to hip-22.5cms

Waist to knee/skirt lenth-56cms

Drafting keys   
1to2:  Half hip measurement +1.5cms square across from 1 

1 to 3:  skirt length, square across to 4 on the centre from L 

1to 5:  waist to hip measurement, square across to 6 on centre front line.

Back part
5to7: 1/4 of hip measurement+1.5 for ease square across front to 8 on the hemline.

1to9: 1/4of waist measurement+4.25 cms

9to10: 1.25cms   Join10topoint 1and7 with dotted line divide the line 1to10 into three parts and mark the point 
11to12

11to13: 14cms

12to14: 12.5cms construct ion of 2 darts on these line each 2cms wide and drawing the side seams curing it

Front part
2to15: 1/4 waist measurement +2.5cms

15to16: 1.25cms join 16 to points 2&7 with dotted lines

16to17: 3rd the distance of 2 using the line 2to16 square from 17 with dotted line

17to18: 10cms.construct a dart on the line 2cms wide drawing the side seam

1to10:  divide in three parts 8.5 equally.

Fig 1

CITS : Apparel - Sewing Technology  - Exercise 1&2 
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SEWING TECHNOLOGY - CITS

TASK 5: Drafting of women’s sleeve block
Measurements:	 size= 8

Sleeve length=25cms, 

Sleeve cap Depth=15cms,

Round Upper Arm=37cm

Drafting keys
1	 Construct the block ABCD where AB=round upper arm measurement+3cms and AC=sleeve length+2cm.

2.	 Divide the sleeve width into half to mark sleeve centre at G.

3	 AE=BF is the sleeve cap depth.

4	 Join GE&GF in a straight line.

5	 Divide EG &GF into four equal portions each and number them as 1.2 and 3.

6	 Mark EG as the front arm scye at 1to go down by 0.75cm and at 3 go 1cm up draw a smooth `s’ curve passing 
through these points.

7	 GF becomes the back arm scye at divide number 3 go up by 1.5cm and go down by 0.5cmin the middle of I 
and F draw a smooth `s’ curve starting G passing over 1.5cm mark and upper 0.5cm mark to reach fin the end.

8	 Mark C (1) C and D (1) D=2cm to get to the round lower arm measurement.

9	 Mark a straight grain parallel to centre sleeves.

TASK 6: Drafting of women’s trouser block
Measurements 
Seat                                      102 cm

Trouser waist                        86 cm

Body rise                               28 cm

Inside leg measurement        81 cm

Trouser bottom width           25 cm

Waistband depth (e.g. uses 4cm waistband )

Topside front
Square down and across from 0.

0 -1    Body rise plus 1 cm minus waistband depth; Square across.

1 -2    Inside leg measurement ;square across.

Fig 1

CITS : Apparel - Sewing Technology  - Exercise 1&2 CITS : Apparel - Sewing Technology  - Exercise 1&2
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SEWING TECHNOLOGY - CITS

2 -3    Half measurement of 1 -2 plus 5 cm; square across. 
1 -4    1/4 body rise measurement ;square across.
1 -5    1/12 seat measurement; plus 1.5 cm ;square up to 6 on seat line , 7 on waistline.
6 -8    1/4 seat measurement plus 2 cm.
5 -9    1/16 seat measurement plus 2 cm.
7 -10   1 cm.
Draw in front curve 9,6 10 as shown in diagram.
10 -11   ¼ trouser waist plus 2.5 cm
2-12      ½ bottom width 
2-13      ½ bottom width
Square up from 12 and 13 to 14n and 15 at knee line draw in side seam through points 11,8,14,12.cure hipline 
outwards 0.5 cm 8-14 out words 0.5 cm 8-14 in words 0.5cm draw in inside leg 9,15,13.cure 9-15 in words 1cm 

Underside/Back
5-16     ¼ measurement 1-5; square up to 17 on the seat line and 18 on the waistline 

19         midway between 16-18 

18-20    1cm 

20-21    1cm

9-22      Half  measurement of 5-9 plus 0.5 cm 

22-23    0.5 cm 

Draw in back fork 23,19,21 as show in diagram 

21-24     ¼ trouser waist plus 4.5 cm

25	midway between 21 and 24; square down from this line. Construct a dart on this line 12cm long 2.5 cm wide 

17-26     ¼ seat measurement plus 3cm 

Fig 1

CITS : Apparel - Sewing Technology  - Exercise 1&2 
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SEWING TECHNOLOGY - CITS

12 -27     2cm 

13-28     2cm.

14-29     2cm

15-30     2cm

Draw in side seam through points 24, 26, 29, 27, curve hem line of trousers down 1cm as in diagram

Body measurement chart for small-medium-large-xlarge sizes 

Trouser

	 	 Chest sizes between	 Small	 Med	 Large	 Xlarge

	 		  (88-92)    	 (96-100)     	 (104-108)       	 (112-116)

	 A	 Chest	 92	 100	 108	 116

	 B	 Seat	 94	 102	 110	 118

	 C	 Natural waist	 75	 83	 91	 99

	 D	 Trouser waist(4cm below                 	 78	 86	 94	 102		
		  natural waist)

	 E-F	 Half back 	 19	 20	 21	 22

	 G-H	 Natural  waist length      	 44	 44.8	 45.6	 46.4

	 G-I	 Scye depth                                             	 23	 24.6	 26.2	 27.8

	 J	 Neck size(easy fitting)                     	 39	 41	 43	 45

	 K-L	 Sleeve length,one –    	 64	 65	 66	 67		
		  piece sleeve

	 E-M	 Sleeve length,two -                      	 80	 82	 84	 86		
		  piece sleeve

	 N-O	 Inside leg                                              	 79	 81	 83	 85

	 P-Q	 Body rice	 27.5	 28.5	 29.5	 30.5

	 R	 Close wrist measurement           	 16.8	 17.6	 18.4	 19.2

		  Extra measurements  

		  Garment length	 Varies with type of garment & with fashion

		  Trouser bottom measurement                    	 24	 25	 26	 27

		  Jeans bottom measurement	 21	 22	 23	 24

CITS : Apparel - Sewing Technology  - Exercise 1&2 CITS : Apparel - Sewing Technology  - Exercise 1&2
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SEWING TECHNOLOGY - CITS

Practice of Pattern Making
Objectives : At the end of this exercise you shall be able to
•	 practice of pattern making.

Tools/Materials
•	 Measurement Chart		  - 1 no.	
•	 Brown paper		  - 8 nos.
•	 Pencil/eraser/scale 		  - each 1 no. 

Requirements

Procedure
TASK 1 : Measure required measurements
WAIST-63.5cms

HIPS-92cms

WAIST TO HIP-22.5cms

WAIST TO KNEE/SKIRT LENTH-56cms

•	 Measurement tape 	 - 1 no.
•	 Marking chalk 	 - 5 nos.	
•	 French curve set 	 - 1 set.	

	

CITS : Apparel - Sewing Technology  - Exercise 1&2 
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SEWING TECHNOLOGY - CITS

TASK 2: Draft the sloper and add zippers and slits

1	 Outline the pattern 2	 Draft the skirt waist line.

3	 Mark the darts and waist points 4	 Draw waist line

Add Zippers and Slits

CITS : Apparel - Sewing Technology  - Exercise 1&2 CITS : Apparel - Sewing Technology  - Exercise 1&2
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SEWING TECHNOLOGY - CITS

TASK 3: Add ease and seam allowance

TASK 4: Add a facing to a skirt

CITS : Apparel - Sewing Technology  - Exercise 1&2 
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SEWING TECHNOLOGY - CITS

TASK 5: Add a waistband to a skirt

TASK 6: Cut the fabric and stich, finish it

CITS : Apparel - Sewing Technology  - Exercise 1&2 CITS : Apparel - Sewing Technology  - Exercise 1&2
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SEWING TECHNOLOGY - CITS

Practice of Grading
Objectives : At the end of this exercise you shall be able to
•	 practice of grading.

Tools/Materials
•	 Basic pattern/pattern 		
•	 Pencil/eraser/scale 		  - each 1 no.
•	 Measurement tape 		  - 1 no. 
•	 pattern cutting scissors 		  - 1 no.
•	 L square  		  - 1 no.	
•	 1 Feet scale  		  - 1 no.

Requirements

Procedure
	 TASK 1: Grade a simple bodice front pattern  

Analyse the Spec. Sheet or measurement chart

•	 Meter scale   	 - 1 no.	
•	 blue ink per  	 - 1 no.
•	 Green ink  per  	 - 1 no.
•	 Red ink per  	 - 1 no.
•	 Brown paper  	 - 1 no.
•	 Measurement spec. sheet  	 - 1 no.	
	

Sl.No Measurements S M L XL

1

2

3

4

5

Length

Chart

Waist

Shoulder

Neck

42

100

80

38

36

44

104

84

40

39

46

108

88

42

42

48

112

92

44

45

With help of the Tools / Instruments and materials, Pre-pare pattern for ‘S’ Size (or Base Size) as shown in the 
following figure. (Fig 1)

Give notations to the pattern points to be graded. (Fig 2)

Fig 1 Fig 2

CITS : Apparel - Sewing Technology  - Exercise 1&2 

© NIMI 

NOT TO BE REPUBLISHED



13

SEWING TECHNOLOGY - CITS

Draw pattern axes on the cut pattern using red ink pen and scale. (Fig 3)

Calculate increments and prepare increment table

Point
S to M M to L L to XL

x y x y x y
1
2
3
4
5
6

0.5
-1
-1
0
1
1

0
0.5
1
1
1
0

0.5
-1
-1
0
1
1

0
0.5
1
1
1
0

0.5
-1
-1
0
1
1

0
0.5
1
1
1
0

Take a brown paper in which the pattern to be graded and draw the axes, and mark the track lines based on the 
increment. Use different colour pens for track nearby for easy identification. (Fig 4)

Fig 3

Place the ‘S’ Size pattern on the paper by matching the origin points. (Fig 5)

Move the pattern on the increments line for both the x and y direction for point 1 and mark the end of the neckline 
and start of the CF line.

Return back the pattern to origin point on the paper

Fig 4
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•	 Move the pattern on the increments line for both the x and y direction for point 2 and mark the start of the 
neckline and start of the Shoulder line.

•	 Return back the pattern to origin point on the paper.

•	 Move the pattern on the increments line for both the x and y direction for point 3 and mark the end of the 
shoulder line and start of the armhole.

•	 Return back the pattern to origin point on the paper.

•	 Move the pattern on the increments line for both the x and y direction for point 4 and mark the end of the 
Armhole and start of the side seam line.

•	 Return back the pattern to origin point on the paper.

•	 Move the pattern on the increments line for both the x and y direction for point 5 and mark the end of the side 
seam line and end of the Waist line.

•	 Return back the pattern to origin point on the paper.

•	 Move the pattern on the increments line for both the x and y direction for point 6 and mark the start of the Waist 
line and end of the CF line. (Fig 6)

Fig 5

Fig 6

CITS : Apparel - Sewing Technology  - Exercise 1&2 

© NIMI 

NOT TO BE REPUBLISHED



15

SEWING TECHNOLOGY - CITS

•	 Remove the pattern from the paper, and join the graded portions with the help of scale (for straight lines) and 
base ‘S’ pattern (for curves). (Fig 7)

•	 Do the same procedure for the remaining sizes for get-ting graded patterns for all the sizes as shown in the 
figure. (Fig 8)

Fig 7

Fig 8
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Practice of Draping
Objectives : At the end of this exercise you shall be able to
•	 practicing of draping

Tools/Materials
•	 Dress Form (Size - 8/10/12) 		
•	 Muslin  Fabric / Cotton Fabric	  - 5 mtr
•	 Draping pins 	 - 1 Set

Requirements

Procedure
TASK 1 : Prepare the Muslin
•	 Measure the dress from 5” down from waist line the fullest part of hip area.

•	 Note down the measurement from centre front to side seam and from center back to side seam at the hip 
level. (Fig 1)

•	 Tear the muslin fabric in length wise grain the desired length of the skirt +3” and in crosswise grain center front 
to center back at the fullest part of the hip area +3”.

•	 Draw a line 3” from top edge of the muslin to indicate waist line. (Fig 2)

•	 Draw a line 7” down from waist line to make a standard hip level.

•	 Draping tape 	 - 1 Roll
•	 Iron box 	 - 1 No.
•	 Tracing paper 	 - 10 sheets

Fig 1 Fig 2

CITS : Apparel - Sewing Technology  - Exercise 1&2 
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TASK 2 : Drape a Skirt

Set the muslin with horizontal balance line.

Pin the fold of muslin to the center front and leave 5” of fabric 
above waist line. 

Place a temporary holding pin and smooth muslin from center 
front to princess line. Pin in waist. 

Trim excess fabric smooth and re pin at princess line. 

Clip the waist right at the princess line and form the flare. 
Release holding pins at the side. 

Rotate the excess fabric on a counter clockwise direction 
dropping the fabric down to form the flare. 

CITS : Apparel - Sewing Technology  - Exercise 1&2 CITS : Apparel - Sewing Technology  - Exercise 1&2
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Pin at the waist and trim excess fabric at princess line to side 
seam. 

Pin ¼” ease tuck and clip to waist. Repin the side seam. 

Smooth fabric and pin to side seam at bottom seam. 

Mark dot at waist. 

Pin the flare right at the base of the form and measure.

Rub the side seam and mark right at form base. 

Mark measurement A-B.

Trim side seam and mark front panel

CITS : Apparel - Sewing Technology  - Exercise 1&2 
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Trimmed fold it away from the side seam and pin. 

Set the muslin with horizontal balance line pin the center back 
using pins.

Place a pin at side seam.

Smooth from center back to princess line.

Pin at waist. 

Trim excel fabric from center back to princess line.

Smooth and repin at waist. Clip to waist at princess line.

Release holiday pins rotate the excess fabric form the flare.

Measure flare right and adjust the fold from the front drape.

The fabric lift higher at the waist to make the flare smaller, 
lower to make the flare large. 
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Pin and Trim excess fabric from princess line to side seam.

Pin a ¼” ease tuck and clip to waist. 

Repin side seam and smooth fabric down. Pin the fabric at the 
base of the form. 

Mark center back and dot at waist. Mark waist at side seam.

Pencil rub at side seam and cram mark at side. Mark A-B 
measurement straight out from their mark and trim side seam. 

CITS : Apparel - Sewing Technology  - Exercise 1&2 
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Fold the side seam from side waist to side flare measurement 
and grease. Pin front to back at waist. Do not pin to form. 

Pin at flare base. Continue to pin up entire side seam. 

Mark the hem at center back and center front. Smooth the side 
seam and mark hem at side. 

Smooth the skirt straight down and mark the hem at two or 
three locations in the back panel. Repeat on front panel and 
Trim mulin to with in 1-1/2” of marked hem.

Take the muslin off the form and unpin the side seam. Repin 
the muslin to pin test the drape. 
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Back view of the finished drape should hang straight of the 
center back fold. 

TASK 3 : Place on the tracing paper
1	 Remove the pins and Iron the muslin using Iron box.
2	 Place the muslin on the tracing paper.
3	 Mark the point square out the pattern.

TASK 4 : Cut the Pattern of Flare Skirt, Stitch and Finish

CITS : Apparel - Sewing Technology  - Exercise 1&2 
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Practice of Stitching
Objectives : At the end of this exercise you shall be able to
•	 Practice of Stitching 

Tools/Materials
•	 Muslin  or other light colored Cotton 	

Fabric	 - 5 mtr
•	 Sewing thread	 - 3 Nos
•	 Sewing machine	 - 1 No
•	 L Scale 	 - 1 No

Requirements

Procedure

•	 Pencil / Eraser                            - Each 1 No
•	 Scissor 10” 	 - 1 No
•	 Iron / Press	 - 1 No

TASK 1: Select your pattern and fabric TASK 2: Prepare your pattern

TASK 3: Prepare and cut out your fabric TASK 4: Mark and sew darts

TASK 5: Sew the back zipper TASK 6:  Sew the shoulder seams
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TASK 7: Prepare the neckline facing TASK 8: Attach neck facings

TASK 9: Press and under stitch neck facing

TASK 10: Sew side seams TASK 11: Prepare the armhole facings

TASK 12: Attach the armhole facings
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TASK 13: Finish back neckline

TASK 14: Secure the facing edges TASK 15: Hem the dress

 

CITS : Apparel - Sewing Technology  - Exercise 1&2 CITS : Apparel - Sewing Technology  - Exercise 1&2

© NIMI 

NOT TO BE REPUBLISHED



26

SEWING TECHNOLOGY - CITS

Objectives
EXERCISE 3 : Familiarize with the working of corel draw

At the end of this exercise you shall be able to
•	 create a basic shape
•	 create a various design
•	 create a human figure.

MODULE 2 : Study of different computer software in 	
			   garment industry

Tools/Materials
•	 Computer / Laptop	 		 - 1 No.
•	 Corel draw software (latest) 	 - 1 No.	 	
•	  Internet facility	 		 - 1 No.

Requirements

Procedure
Introduction of Corel Draw
CorelDraw is a family of software programs used for editing vector graphics, illustration and design. Vector 
graphics are created in graphics packages and consist of objects. Each object can be edited separately, meaning 
that the shape, colour, size and position can be changed without losing quality.
Benefits of Corel Draw
Fashion and textile design produce beautiful, bespoke apparel and textile designs with industry-leading tools in 
CorelDraw Graphics Suite.  Create CAD garments, and prepare designs to output as screen printing, embroidery, 
direct-to-garment printing, and more
CorelDraw is the most popular vector design software in the professional computer-aided fashion design industry, 
with many fashion designers using it to draw their mannequins and produce their designs.
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Tool Box in Corel Draw
The toolbox contains tools for drawing and editing images. Some of the tools are visible by default, while others 
are grouped in flyouts. Flyouts open to display a set of related Corel draw tools.

Some tools in the toolbox are not visible by default. Choose which tools to be displayed in the toolbox.
To toggle between displaying and hiding the toolbox, click Window  Toolbars  Toolbox.

CITS : Apparel - Sewing Technology  - Exercise 3
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Using Tools in corel draw

Tool Name Description
Pick tool Lets you select and transform objects
Shape tool The Shape tool lets you edit the shape of objects.
Zoom tool The Zoom tool lets you change the magnification level in the Drawing 

window.
Freehand tool The Freehand tool lets you draw lines and curves.

Rectangle tool The Rectangle tool lets you draw rectangles and squares.
Ellipse tool Lets you draw ellipses and circles

Pentagon tool Lets you draw polygons and stars

Basic shapes tool Lets you choose from a full set of shapes, including hexagram, a smiley 
face, and a right-angle triangle.

Text tool Lets you type words directly on the screen as artistic text or a 
paragraph text.

Interactive 
distraction tool

Lets you apply a Push or Pull distortion, a Zipper distortion, or a Twister 
distortion to an object

Eyedropper tool Lets you select a fill from an object on the Drawing window.

Outline tool Opens a flyout that lets you set the outline properties

Fill tool Opens a flyout that lets you set fill properties.

Interactive fill tool Lets you apply various fills.

CITS : Apparel - Sewing Technology  - Exercise 3
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Important tools in Corel Draw 
Pick Tool 

Shape Tool 

	
The use of pick tool is to activate, select or move objects.

This tool allows to change the shape of objects more freely, and to master this  
tool, it may take a little time and experience.

Zoom Tool 

As the name implies, this tool is used to enlarge or minimize the appearance 
of the object, the use of this tool itself is very rarely used for professional  
designers, because to zoom in or out objects, designers only need to use the 
scroll wheel of the mouse.

Freehand Tool 

Used to create a line, by activating the starting point and end point of the line.

Rectangle Tool 

This tool makes it easier to create rectangles or rectangles more precisely.

Ellipse Tool 

As well as the rectangle tool, but the ellipse tool is the tool used to create  
circles or ovals.
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Polygon Tool 

Polygon tool is a tool used to create objects other than square, such as  triangles, 
pentagon, and various other facet objects.

Text Tool 

This is a tool used to create a text object or text.

Transparency Tool 

This tool is used to create a transparent object, either uniformly or gradation.

Colour eyedropper Tool

The usefulness of this tool is to take a colour from a format to be used into the  
desired object of the designer.

Fill Tool/Gradations Tool

This tool is used to create gradations of two or more colours.

Smart Fill Tool

This tool is used to form an object of space created by sketch lines.

CITS : Apparel - Sewing Technology  - Exercise 3
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Drawing Shapes
Corel draw has different shape tools that can be used to create ellipse (including circles), rectangle (including 
squares), polygons, stars and some basic shapes.
Drawing rectangles and squares
Drawing a Rectangle
1   	To draw a rectangle, select the Rectangle tool in the toolbox. The mouse pointer changed to a crosshair with 

a small rectangle beneath it.
2   	Click and drag anywhere in the drawing area. While dragging, a rectangle appears.
3    Release the mouse button when the rectangle is of the desired size.
4    Now a rectangle will appear on the screen.

Drawing a Square
1	 To draw a square, select the Rectangle tool in the toolbox. The mouse pointer changes to a crosshair with a 

small rectangle beneath it.
2 	 Click on anywhere in the drawing area and hold down the Ctrl key while dragging the mouse pointer.
3 	 Release the mouse button when desired end of the square is reached.
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Creating a Rounded Rectangle
After drawing a rectangle, optionally corners can be rounded. All corners can be rounded at once or choose 
the corners to be rounded. Corners can be slightly rounded to create a softening effect or very rounded, almost 
changing the rectangle into a circle.

To round the corners of a rectangle:
1 	 In the toolbox, select the Shape Tool icon from the Shape Tool layout or press F10 key.
2 	 Select the rectangle to round. Four black nodes will appear around the rectangle.

Creating ellipses
1 	 To draw an ellipse (also known as an oval), select the Ellipse tool in the toolbox. The mouse pointer changes 

to a crosshair with a small ellipse beneath it.
2 	 Click on anywhere in the drawing area and drag the mouse pointer.
3 	 Release the mouse button when the desired end of the ellipse is reached.

CITS : Apparel - Sewing Technology  - Exercise 3
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Creating Circles
1 	 To draw a circle, select the Ellipse tool in the toolbox. The mouse pointer changes to a crosshair with a small 

ellipse beneath it.
2 	 Click on anywhere in the drawing area and hold down the Ctrl key while dragging the mouse pointer.
3 	 Release the mouse button when the desired end of the circle is reached.

Creating Polygons
1 	 To draw a polygon (also known as pentagon: a five-sided figure), select the Polygon tool in the toolbox. The 

mouse pointer changes to a cross-hair with a small polygon beneath it.
2 	 Click on anywhere in the drawing area and drag the mouse pointer.
3 	 Release the mouse button the desired end of the polygon is reached.
4 	 To increase the number of sides of polygon, select the polygon already drawn using the Pick tool.
5 	 Place the mouse pointer on the Number of Points on Polygon text box and type the number of sides for the 

polygon.
Number of sides for the polygon can be set and then drawn.
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Creating Stars
Polygon tool has a small arrow in the lower- right corner of the tool. That little arrow indicates that this tool has a 
flyout.
To draw a star,
1 	 Click on the Polygon tool and hold down the mouse key. A flyout menu will appear showing other tools.
2 	 Click on the Star tool from the flyout menu.
3 	 Click on anywhere in the drawing area and drag the mouse pointer.
4 	 Release the mouse button when the desired end of the star is reached.

Drawing Spirals
There are two types of spirals. They are
1 	 Symmetrical spiral
2 	 Logarithmic spiral.
A Symmetrical spiral expands evenly so that the distance between each revolution is equal. A Logarithmic spiral 
expands with increasingly larger distances between revolutions.
Spirals of different sizes can be drawn with Spiral tool.
To draw a spiral,
1    Click and hold the Polygon tool. A flyout menu will appear.
2    Click on the Spiral tool from the flyout menu.
3  	A value should be entered in the Spiral revolutions box on the property bar to set the number of full-circle 

revolutions to appear in the new spiral object.
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4	 Next, click one of the following buttons on the property bar:
a    Symmetrical spiral
b    Logarithmic spiral

If the amount by which the spiral expands as it moves outward need to be changed, move the Spiral expansion 
slide.
5	 Drag diagonally in the drawing window until the spiral is the required size.

Drawing Grids
Using Graph Paper tool, grid can be drawn and set the 
number of rows and columns. A grid is a grouped set of 
rectangles that can be broken apart.
To draw a grid,
1     Click and hold the Polygon tool. A flyout menu will 

appear.
2   Select the Graph Paper tool from the flyout menu.
3     Enter values in the top and bottom portions of the 

Columns and rows box on the property bar.
The value entered in the top portion of the Columns and 
rows box specifies the number of columns; the value 
entered in the bottom portion specifies the number of rows.
4   Click on anywhere in the drawing area where the grid 
needs to be appeared.
5   Drag diagonally to draw the required grid.
If the grid needs to be drawn from its center point outward, 
hold down Shift key as dragged; and to draw a grid with 
square cells, hold down Ctrl key as dragged.
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Drawing in Freehand mode
To draw a straight line
1 	 Click the Freehand tool (or) press F5 in the keyboard.
2 	 Move the cursor where the line should be started and click once.
3 	 Move the cursor towards the position for the endpoint.
A 	 “rubber band” line will appear, which follows the cursor.
4 	 Release the mouse button to desired point to end the line. The line will 

be drawn.
5 	 To draw a second straight line connected to the first, continue with 

Freehand tool, and click again on the endpoint of the last segment.
6 	 Move the cursor to draw the second segment. Click once when the 

desired second segment is positioned correctly. Repeat steps 5 and 6 
to draw as many segments as require.

Remember to click at two points - the beginning and end of the segment.

Adding arrowheads to lines
To add arrowhead to a line
1 	 Using the Freehand tool draw a line.
2 	 Select the line.
3 	 Click the drop-down button on the End Arrowhead Selector on the Property tool bar.
Then click the desired arrow tip. Now the line appears with an arrow.
4 	 The line style, width, and the colour of the line can be set using the Properties bar.

CITS : Apparel - Sewing Technology  - Exercise 3

© NIMI 

NOT TO BE REPUBLISHED



37

SEWING TECHNOLOGY - CITS

Drawing the parts of mannequin in Corel Draw 
Step 1
To start drawing the head and neck, use two ellipses and a rectangle (using the Ellipse and Rectangle tools from 
the Toolbox). Using the Polygon tool, create a pentagon (5-side polygon) for the torso, and with the Ellipse tool, 
create two circles for the shoulders. To complete the upper part of the body, draw two rectangles and then, using 
the Pick tool, turn them a few degrees to find the right inclination. Then create two circles to function as elbows, 
as shown in the following image.

Step 2
To create the pelvis, use a pentagon that will stretch using the Pick tool and two circles in its base that will serve 
as joints for the legs.
To draw the forearm, use a pentagon and a triangle. The hand will be made of another downward-facing pentagon 
joined to the forearm by a circle, as illustrated below.

Step 3
To draw the leg and foot, use four pentagons and two triangles, and two circles for the knee and ankle respectively.
Once one leg is created, duplicate it and place the two side-by-side. Using the Pick tool, rotate some of the 
components in order to get asymmetry and movement.
At this point, the mannequin already has all of its elements, comprised exactly of 37 basic objects. View them in 
the Object manager docker. To open the Object manager, click on the Window menu > Dockers > Object Manager
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Reducing the number of objects by welding
Once the mannequin has all of its components, optimize it using the shaping tools mentioned earlier. More 
specifically, use the Weld and Trim options.
To simplify the future use of the mannequin, reduce the number of components by welding some of them together.
Start by joining the torso to the neck. Select both shapes (the pentagon and the rectangle) and click on the Weld 
button on the Property Bar, and thus both shapes will become a single object.

Weld also the two ellipses that form the head into a single object. Then select the two polygons that form the 
forearm and Weld them together. To help visualize the results, it is a good idea to select the resulting objects 
using the Pick tool and apply a fill colour to them by clicking on the colour of preference from the colour palette. 
Continue welding the polygons that form the thighs, the calf’s and the feet until a result similar to the following 
image is obtained.
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Trimming shapes to obtain movement in the joints
The number of components of the original figurine has now been reduced to 27. In order to provide mobility to 
the joints trim the areas where the objects come together using the Trim option from the Property Bar. Start by 
selecting the ellipse that forms the shoulder, clicking the Trim option and then clicking the pentagon that forms the 
torso. Since the triangle that forms the forearm extends to the hand, the pentagon that forms the hand needs to 
be selected, then activate the Trim option and click on the forearm triangle. This way, the hand and forearm will 
be ready.
Continue trimming all the ellipses that make up the joints of the adjacent objects. If the object that forms the head 
appears behind the neck, click on the Object menu > Order > In Front Of... and add a white fill colour to distinguish 
it better. To create the ankles, follow the same procedure as with the wrists: select the object that represents the 
foot, activate the Trim option and click on the calf object, then trim the ellipse corresponding to the ankle.
 

Now that the mannequin is ready, delete the lines that is used as guides, by choosing the Pick tool, clicking on 
each one of them and pressing the Delete key.
To unify the appearance of the figurine, select all the objects that comprise it with the Pick tool and click on the 
black colour of the colour palette.
Now, the versatility of the mannequin can be tested that is just created.

Changing the mannequin’s poses
Using the Pick tool and its skewing and rotating functions, the joints can be selected and give new mannequin 
movement, and position it in as many poses as required. The possibilities are endless, as shown in the below 
example.
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Designing own fashion with basic shapes
The possibilities of the basic shape drawing tools to create mannequins is learned, but there is much more 
creative power in these tools. Now that the geometric mannequin is available as a starting point, try dressing it 
using the techniques for drawing basic shapes, trimming and welding as shown below:
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Objectives

EXERCISE 4 : Create patterns with the help of Adobe 		
	 Photoshop (Latest Software)

At the end of this exercise you shall be able to
•	 create a digital design
•	 create a digital illustration

Tools/Materials
•	 Computer / Laptop	 		 	 - 1 No.
•	 Adobe photoshop / photo shop (latest) 	 - 1 No.	 	
•	 Internet facility	 		 	 - 1 No.

Requirements

Procedure
Photoshop’s features
Photoshop comes with a multitude of features, fonts, effects, and brush or pen tools. Here are some of the most 
common ones:

•	 Brushes are one of the most popular tools in Photoshop. They can be used for various effects, 
including compositing, painting, erasing and retouching images.   

•	 The Clone Stamp allows you to copy pixels from one area of an image and paste them into   another 
area. This is useful for repairing damaged or corrupt images.
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•	 The Healing Brush is similar to the Clone Stamp, but it blends the copied pixels with  the surrounding 
pixels for a more natural look. 

•	 The History Brush allows you to revert an image to a previous state. This is useful for undoing mistakes 
or going back to a point in your workflow where you were happy with the image.

•	 Blur blurs the pixels in an image, making them less distinct. This can be used to create a soft, dreamy 
look or reduce the appearance of wrinkles and other imperfections.
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•	 Sharpen does the opposite of Blur, making pixels more distinct. This can be useful for making an image 
appear more transparent or creating a more dramatic effect.

•	  Dodge and Burn are used to lighten or darken areas of an image. These are commonly used 
in photo retouching to make subjects appear more defined.

•	 The Sponge tool can either absorb or release colour from an image. This is useful for correcting colours 
that are too light or too dark.
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Photoshop is an essential tool for fashion designers due to its versatile capabilities in image editing, design 
creation, and visual communication. Here are some reasons why Photoshop is required for fashion designers:
1	 Image Editing 
Fashion designers often work with images of models, fabrics, textures, and accessories. Photoshop allows 
designers to edit these images, adjust colours, retouch imperfections, and manipulate elements to achieve the 
desired aesthetic.

2	 Design Creation 
Photoshop provides powerful tools for creating digital designs, illustrations, and sketches. Designers can use 
brushes, shapes, layers, and other features to bring their ideas to life digitally, allowing for experimentation and 
iteration before finalizing designs.
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3	 Textile Design
Many fashion designers create their own textile patterns and prints. Photoshop offers tools for creating intricate 
patterns, repeating designs, and applying them to fabric mock-ups, allowing designers to visualize how patterns 
will look on garments.

4	 Mock-ups and Prototyping
Before producing physical samples, fashion designers often create digital mock-ups and prototypes to visualize 
their designs. Photoshop enables designers to create realistic mock-ups of garments, incorporating textures, 
patterns, and details to accurately represent the final product.

5	 Visual Communication
Photoshop is widely used for creating mood boards, look books, and presentations to communicate design 
concepts and ideas. Designers can compile images, sketches, swatches, and typography in Photoshop to create 
visually compelling presentations for clients, collaborators, and stakeholders.
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6	 Photo Manipulation and Retouching
In the fashion industry, high-quality photography is essential for marketing and promotional materials. Photoshop 
allows designers to enhance photographs, adjust lighting, remove blemishes, and retouch models to create 
polished and professional images.

7	 Collaboration and Integration 
Photoshop seamlessly integrates with other design software and tools commonly used in the fashion industry, 
such as Adobe Illustrator and Adobe InDesign. This interoperability facilitates collaboration among designers, 
photographers, and marketers, streamlining the design process from concept to production.
Creating a Digital Illustration in Photoshop
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Step 1: Setting up the Canvas
1	 Open Adobe Photoshop and create a new document (File > New). Set the dimensions to your preferred size, 

such as 8x10 inches for a standard illustration.
2	 Choose a resolution of 300 pixels/inch for high-quality printing.
3	 Click OK to create the canvas.

Step 2: Sketching
1	 Create a new layer above the background layer.
2	 Use a digital drawing tablet or the Pen Tool (P) to sketch the outline of your fashion figure. Start with basic 

shapes and lines to define the pose and proportions.
3	 Refine the sketch, adding details like facial features, clothing folds, and accessories.

Step 3: Adding Base Colors
1	 Create a new layer beneath the sketch layer and name it “Base Colors.”
2	 Use the Brush Tool (B) to fill in the base colors for the different elements of your illustration, such as skin, hair, 

clothing, and accessories.
3	 Use a soft brush with low opacity for smoother color transitions.

CITS : Apparel - Sewing Technology  - Exercise 4
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Step 4: Adding Shading and Highlights
1	 Create a new layer above the base colors layer and name it “Shading.”
2	 Use a darker shade of each base color to add shadows where light wouldn’t hit directly. Consider the direction 

of light source for consistency.
3	 Create another new layer above the shading layer and name it “Highlights.”
4	 Use a lighter shade of each base color to add highlights where light hits directly, such as on protruding edges 

and shiny surfaces.

Step 5: Refining Details
1	 Create new layers as needed for additional details like patterns, textures, and embellishments.
2	 Use various brushes, such as textured brushes or pattern stamps, to add details to clothing, accessories, and 

background elements.
3	 Experiment with layer blending modes and opacity levels to achieve desired effects.
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Step 6: Final Touches
1	 Merge visible layers or create a stamped layer (Ctrl/Cmd + Alt + Shift + E) for final adjustments.
2	 Use adjustment layers (e.g., Levels, Hue/Saturation) to tweak colours and tones if necessary.
3	 Add a background or decorative elements to enhance the overall composition.
4	 Save your illustration in a suitable format (e.g., PSD for further editing, JPEG for sharing).

Step 7: Optional - Presentation
1	 Create a new document for presentation purposes.
2	 Place your fashion illustration onto this document.
3	 Add your name or branding, title, and any additional information.
4	 Save the final presentation document.

CITS : Apparel - Sewing Technology  - Exercise 4

© NIMI 

NOT TO BE REPUBLISHED



50

SEWING TECHNOLOGY - CITS

SOFTWARE - 1
(5 - 28)
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Objectives

EXERCISE 5 : Use Software tools for Pattern Making

At the end of this exercise you shall be able to
•	 identify the pattern making tools
•	 understand different types of tools used in pattern making
•	 how to use the pattern. 

Tools/Materials
•	 Computer with pattern making software (Latest Version)		  - 1 No. 	

Requirements

Procedure
1	 Piece
Shortcut:
Key: Ctrl + F4 or Alt + P + N

Toolbar:

Figure 1.1: Confirmation dialog box

Figure 1.2: Create Piece dialog box

MODULE 3 : Pattern Design Software Tools and its 	
	 Applications Software - 1
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What?
What are the various options/features available in the PIECE sub-menu?

1	 SNo - It gives the serial number of the entries

2	 Name - It is used to specify the name of the piece

3	 Left - It is used to specify the distance of the piece from the left

4	 Top - It is used to specify the distance of the piece from the top

5	 Width - It is used to specify the width of the piece

6	 Height - It is used to specify the height of the piece

7	 Apply - It is used to apply the changes mentioned in the list

8	 Open - It is used to open any pre-existing list of the attributes of the piece in the device.

9	 Save - It is used to save the list entered in the piece attribute table.

10	Back - It is used to go to the previous list of the sub-menu.

Where?
Where can the PIECE sub-menu be found?

•	 As you will open the REACH PDS, there in the menu bar you will find the PIECE Menu.

•	 As you will click on the Piece Menu (or use the shortcut key alt+P), a dropdown menu will appear

•	 In that, the first option will be the New sub-menu.

•	 As you will click on that you will get the options in the Menu Tablet

•	 From there you can select the Piece option

OR

Figure 1.3: REACH PDS Screen showing New sub-menu
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In the dialog box when you click on the No in Figure 1.1, you will see Figure 1.4. From here you can access any 
of the sub-menu

Why?
Why is the PIECE sub-menu used?

It is used to create a new Piece or to delete unwanted blocks

How?
 How to use the PIECE sub-menu?

•	 Single-click on the Piece button on the Menu Tablet.

•	 Click Yes when you see the confirmation dialog box as in Figure 1.1

•	 A Create Piece dialog box opens as in Figure 1.4.

•	 Enter the name of the block, left and top (which will show the working area) and then enter width and height of 
the block and click on apply.

•	 Click on the Zoom All icon to enlarge the view of the block.

•	 You can now start tracing.

2	 Select
Shortcut:
Key: Ctrl + F4 or Alt + E + S

Toolbar:  

Figure 1.4: New Menu Tablet

Figure 2.1: Select Menu Tablet
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What?
What are the various options/features available in the SELECT sub-menu?

1	 Tracing in Area - This is to select all our tracings using area selection/window method.

2	 Internal - This is to select all our internal elements created inside a piece. Notch is not selected using thistool.

3	 Tracing - This is to select a tracing segment-wise. This will enable you to select individual tracing segments 
instead of tracings within the selected area.

4	 Grade area - This is to select single/multiple grading points by using area selection/window method.

5	 Back - It is used to go to the previous list of the sub-menu.

Where?
Where can the SELECT sub-menu be found?

•	 As you will open the REACH PDS, there in the menu bar you will find the EDIT Menu.

•	 As you will click on the Edit Menu (or use the shortcut key alt+E), a dropdown menu will appear

•	 In that, the third option will be the Select sub-menu.

OR                            

Figure 2.2: REACH PDS Screen showing Select sub-menu

Figure 2.3: Edit Menu Tablet
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	 In the bottom-right corner when you click on the Back (5) in Figure 2.1, you will see Figure 2.3. From here you 
can access any of the sub-menu

Why?
Why is the SELECT sub-menu used?

It is used to select a Tracing in Area/ Internal/ Tracing/ Grade Area.

How?
How to use the SELECT sub-menu?

•	 Click on the Select icon from the toolbar or click on the Select sub-menu from the Edit menu

•	 Click on the option that you want to select

•	 Hover on the tracing & as it turns in red-green dotted line, click on that. That will be selected

3	 Delete
Shortcut:
Key: Ctrl + X or Alt + E + T

Toolbar:   

Where?
Where can the DELETE sub-menu be found?

•	 As you will open the REACH PDS, there in the menu bar you will find the EDIT Menu.

•	 As you will click on the Edit Menu (or use the shortcut key alt+E), a dropdown menu will appear

•	 In that, the fourth option will be the Delete sub-menu.

OR

Figure 3.1: REACH PDS Screen showing Delete sub-menu
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In the bottom-right corner you will see Figure 3.2. From here you can access any of the sub-menu

Why?
Why is the DELETE sub-menu used?

It is used to delete anything other than a pattern like tracing or trace segment

How?
How to use the DELETE sub-menu?

Figure 3.2: Edit Menu Tablet

Snippet_31C2F0602.idms

Figure 3.3: REACH PDS Screen showing the use of Delete sub-menu
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•	 Click on the Select icon from the toolbar or click on the Select sub-menu from the Edit menu

•	 Click on the option that you want to select

•	 Hover on the tracing & as it turns in red-green dotted line, click on that. That will be selected

•	 Click on the Delete icon or Delete sub-menu from the Edit Menu 

4	 Move Piece
Shortcut:
Key: Shift + F10 or Alt + D + M
Toolbar:

What?
What are the various options/features available in the MOVE sub-menu?

1	 Length - It is used to specify the length by which it has to be moved

2	 Angle - It is used to specify the angle at which it has to be moved

3	 Anywhere - It helps to move anywhere in the working area

4	 Horizontal - It helps to move only in the horizontal direction

5	 Vertical - It helps to move only in the vertical direction

6	 Apply - It is used to apply the changes mentioned in the Other dialog box

7	 Drop-Down - It is a drop-box giving the different possible things can be moved

8	 Back - It is used to go to the previous list of the sub-menu.

Where?
Where can the MOVE sub-menu be found?

Figure 4.1: Move Menu Tablet
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•	 As you will open the REACH PDS, there in the menu bar you will find the DRAW Menu.

•	 As you will click on the Draw Menu (or use the shortcut key alt+D), a dropdown menu will appear

•	 In that, the tenth option will be the Move sub-menu.

OR

In the bottom-right corner when you click on the Back (8) in Figure 4.1, you will see Figure 4.3. From here you 
can access any of the sub-men4

Why?
Why is the MOVE sub-menu used?

This is used to move a Pattern, Internal, Tracing, Pattern Point, Tracing Point etc

How?
How to use the MOVE sub-menu?

Figure 4.2: REACH PDS Screen showing Move sub-menu

Figure 4.3: Draw Menu Tablet
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•	 Single-click on the Move option from Draw Menu.

•	 You will see a dialog box as shown in Figure 4.1 at Menu Tablet.

•	 Select the type of drawing to be moved through the dropdown in the combo box.

•	 Select the direction where you want to move, length or angle at which you want to movie and click on Apply.

•	 Select the move parameter from the Menu Tablet.

•	 Using the cursor move the object to the new location.

	 Note: Moving of an object is context sensitive. The object clicked on will become the active selection 
automatically.

•	 If you want to align any two patterns at a certain point, Hold down the Ctrl Key; click on the desired point of one 
pattern and then drag it to the desired point on the second pattern.

5	 Save
Shortcut:
Key: Ctrl + S or Alt + P + S

Toolbar:  

Figure 4.4: REACH PDS Screen showing the use of Move sub-menu

Figure 5.1: Save dialog box
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What?
What are the various options/features available in the SAVE sub-menu?

1	 Save- It is used to save the file in the default folder that is mentioned above the menu bar

2	 Save with History- It is used to save the file along with the history & comments

Where?
Where can the SAVE sub-menu be found?

•	 As you will open the REACH PDS, there in the menu bar you will find the PIECE Menu.

•	 As you will click on the Piece Menu (or use the shortcut key alt+P), a dropdown menu will appear

•	 In that, the sixth option will be the Save sub-menu.

Figure 5.2: Comment dialog box in Save

 Figure 5.3: REACH PDS Screen showing Save sub-menu

CITS : Apparel - Sewing Technology  - Exercise 5

© NIMI 

NOT TO BE REPUBLISHED



61

SEWING TECHNOLOGY - CITS

CITS : Apparel - Sewing Technology  - Exercise 5

Why?
Why is the SAVE sub-menu used?

It is used to save a piece

How?
How to use the SAVE sub-menu?

•	 Single-click on the Save from the Piece Menu Bar.

•	 You will see the Save dialog box as in Figure 5.1.

•	 If you will click on Save in that, the file will be saved in the default folder which will be mentioned above the 
menu bar

•	 If you will click on Save with History, you will see a dialog box as shown in Figure 5.2.

•	 Write the comment & click on Save to save the file.

6	 New
Shortcut:
Key: Ctrl + F4 or Alt + P + N

Toolbar:  

What?
What are the various options/features available in the NEW sub-menu?

1	 Style - It is used to create a new Style

2	 Piece - It is used to create a new Piece or to delete unwanted blocks

3	 Tracing - It is used to delete all tracings

4	 Back - It is used to go to the previous list of the sub-menu.

Where?
Where can the NEW sub-menu be found?

Figure 6.1: New Menu Tablet
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•	 As you will open the REACH PDS, there in the menu bar you will find the PIECE Menu.

•	 As you will click on the Piece Menu (or use the shortcut key alt+P), a dropdown menu will appear

•	 In that, the first option will be the New sub-menu.

OR

	 In the bottom-right corner when you click on the Back (4) in Figure 6.1, you will see Figure 6.3. From here you can 
access any of the sub-menu

Why?
Why is the NEW sub-menu used?

It is used to create a new Style, Piece or clear the tracing

How?
How to use the NEW sub-menu?

•	 Click on New in Piece Menu

Figure 6.2: REACH PDS Screen showing New sub-menu

Figure 6.3: REACH PDS menu tablet
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•	 In the menu tablet, you will see three options as shown in Figure 6.1

•	 Select any one of the option as per the requirement of adding Piece or Style or removing Style or Tracing.

7	 Open
	 Note: If you have created a Style file and not saved the pieces, you cannot open that Style file. Do 

save the files. In such cases, create the same Style file again.

Open Existing Style 
Shortcut:
Key: Ctrl + O or Alt + P + O

Toolbar:  

What?
What are the various options/features available in the OPEN EXISTING STYLE sub-menu?

1	 Select Style- It is used to select any style which is already saved in the system

2	 OK- It is used to apply the changes mentioned in the table

3	 Cancel- It is used to cancel any changes made in the dialog box

Where?

Figure 7.1: Open Existing Style Menu Tablet
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Figure 7.2: REACH PDS Screen showing Open Existing Style sub-menu

Where can the OPEN EXISTING STYLE sub-menu be found? 
•	 As you will open the REACH PDS, there in the menu bar you will find the PIECE Menu.
•	 As you will click on the Piece Menu (or use the shortcut key alt+P), a dropdown menu will appear
•	 In that, the fifth option will be the Open (Open Existing Style) sub-menu.
Why?
Why is the OPEN EXISTING STYLE sub-menu used?
It is used to open existing style folder / storage area
How?
How to use the OPEN EXISTING STYLE sub-menu?
•	 Single-click on the Open button from the Piece Menu Bar.
•	 A confirmation dialog box appears for saving the existing modified Piece. If you want the changes to be 

updated in the piece, click yes or else click no.
•	 You will see the Open Existing Style dialog box as shown in Figure 7.1.
•	 Select the Storage Areal Folder that you want to open and click ok.

8  Open Tracing 

Figure 8.1: Open Tracing dialog box
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Where?
Where can the OPEN TRACING sub-menu be found?

•	 As you will open the REACH PDS, there in the menu bar you will find the PIECE Menu.

•	 As you will click on the Piece Menu (or use the shortcut key alt+P), a dropdown menu will appear

•	 In that, the eighth option will be the Open Tracing sub-menu.

Why?
Why is the OPEN TRACING sub-menu used?

It is used to open a tracing that is already saved

How?
How to use the OPEN TRACING sub-menu?

•	 Single-click on the Open Tracing button from the Piece Menu Bar.

•	 You will see the Open dialog box as in Figure 8.1.

•	 Select the Tracing Storage Area and click on the Open button.

9	 Help
Shortcut:
Key: Alt + H

Where?
Where can the HELP menu be found?

Figure 8.2: REACH PDS Screen showing Open Tracing sub-menu
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Figure 9.1: REACH PDS Screen showing Help menu

•	 As you will open the REACH PDS, there in the menu bar you will find the HELP Menu.

•	 As you will click on the Help Menu (or use the shortcut key alt+H), a dropdown menu will appear

•	 In that, you will find various topics on which you can find help.

OR

	 In the bottom-right corner when you click on the Back, you will see Figure 9.2. From here you can access the 
HELP menu

Why?
Why is the HELP menu used?
It is used to get help for the users navigate the product through quick access to useful resources
How?
How to use the HELP menu?
•	 Click on the HELP menu bar
•	 You will see the dropdown as in Figure 9.1. 
10	Zoom
Shortcut:
Key: Alt + V + Z

Figure 9.2: REACH PDS menu tablet
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Figure 10.1: Zoom Menu Tablet

What?
What are the various options/features available in the ZOOM sub-menu?

1	 Zoom in- It is used to focus on a smaller section at a time by increasing its overall size for greater detail.

2	 Zoom Out- It is used to focus on a larger section at a time by decreasing its overall size for greater detail.

3	 Zoom All- It is used to focus everything on the screen

4	 Back- It is used to go to the previous list of the sub-menu.

Where?
Where can the ZOOM sub-menu be found? 

Figure 10.2: REACH PDS Screen showing Zoom sub-menu
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•	 As you will open the REACH PDS, there in the menu bar you will find the VIEW Menu.
•	 As you will click on the View Menu (or use the shortcut key alt+V), a dropdown menu will appear
•	 In that, the first option will be the Zoom sub-menu.
OR

	 In the bottom-right corner when you click on the Back (4) in Figure 10.1, you will see Figure 10.3. From here you 
can access any of the sub-menu
Why?
Why is the ZOOM sub-menu used?

It is used to focus on a selected area by either increasing or decreasing its overall size.

How?
How to use the ZOOM sub-menu?
•	 Single-click the Zoom button on the View Menu.
•	 From there choose which type of zoom you want to use
•	 If you select the Zoom In or Zoom Out option, then select the area on which you want to perform it & that area 

will be increase or decrease as per your selection

•	 If you select the Zoom All, then the entire section will be increased.

11	Cut (Delete)
Same as 5. Delete

12	Copy (Duplicate)
Shortcut:
Key: Shift + F8 or Alt + D + D

Toolbar:

Figure 12.1: Duplicate Menu Tablet

Figure 10.3
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What?
What are the various options/features available in the DUPLICATE sub-menu?

1	 Pattern- To duplicate a pattern piece to pattern piece.

2	 Pattern segment- To duplicate a pattern segment to trace segment.

3	 Trace segment- To duplicate a trace segment to trace segment.

4	 Internals- To duplicate internals to trace segments. This option is same as Duplicate Pattern Segment. Refer 
Pattern Segment.

5	 Back- It is used to go to the previous list of the sub-menu.

Where?
Where can the DUPLICATE sub-menu be found?

•	 As you will open the REACH PDS, there in the menu bar you will find the DRAW Menu.

•	 As you will click on the Draw Menu (or use the shortcut key alt+D), a dropdown menu will appear

•	 In that, the eighth option will be the Duplicate sub-menu.

OR

	 In the bottom-right corner when you click on the Back (5) in Figure 12.1, you will see Figure 22.7. From here you 
can access any of the sub-menu

Why?
Why is the DUPLICATE sub-menu used?

It is used to create a copy (duplicate) any pattern, pattern segment, trace segment or internal

How?
How to use the DUPLICATE sub-menu?

•	 Select the Duplicate sub-menu from the Draw menu

Figure 12.2: REACH PDS Screen showing Duplicate sub-menu
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•	 Select the option related what you want to duplicate from the drop-down or from the menu tablet as shown in 
Figure 11.1

•	 Single click on any of the point of the diagram.

•	 It will stick to the point of the cursor & will move along with it

•	 Single click on the working area where you want to paste that & it will be duplicated

13	Mirror Line
	 Refer 12th Point

14	Select and move internals
a	 Select 
Shortcut:
Key: Ctrl + F4 or Alt + E + S

Toolbar:  

What?
What are the various options/features available in the SELECT sub-menu?

1	 Tracing in Area - This is to select all our tracings using area selection/window method.

2	 Internal - This is to select all our internal elements created inside a piece. Notch is not selected using this tool.

3	 Tracing - This is to select a tracing segment-wise. This will enable you to select individual tracing segments 
instead of tracings within the selected area.

4	 Grade area - This is to select single/multiple grading points by using area selection/window method.

5	 Back - It is used to go to the previous list of the sub-menu.

Where?

Where can the SELECT sub-menu be found?

Figure 14.1: 0Select Menu Tablet
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Figure 14.2: REACH PDS Screen showing Select sub-menu

•	 As you will open the REACH PDS, there in the menu bar you will find the EDIT Menu.

•	 As you will click on the Edit Menu (or use the shortcut key alt+E), a dropdown menu will appear

•	 In that, the third option will be the Select sub-menu.

OR

	 In the bottom-right corner when you click on the Back (5) in Figure 14.1, you will see Figure 14.3. From here you 
can access any of the sub-menu

Why?
Why is the SELECT sub-menu used?

It is used to select a Tracing in Area/ Internal/ Tracing/ Grade Area.

How?
How to use the SELECT sub-menu?

•	 Click on the Select icon from the toolbar or click on the Select sub-menu from the Edit menu

•	 Click on the option that you want to select

•	 Hover on the tracing & as it turns in red-green dotted line, click on that. That will be selected

Figure 14.3: Edit Menu Tablet
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b	 Move Piece
Shortcut:
Key: Shift + F10 or Alt + D + M
Toolbar:

What?
What are the various options/features available in the MOVE sub-menu?
1	 Length - It is used to specify the length by which it has to be moved
2	 Angle - It is used to specify the angle at which it has to be moved
3	 Anywhere - It helps to move anywhere in the working area
4	 Horizontal - It helps to move only in the horizontal direction
5	 Vertical - It helps to move only in the vertical direction
6	 Apply - It is used to apply the changes mentioned in the Other dialog box
7	 Drop-Down - It is a drop-box giving the different possible things can be moved
8	 Back - It is used to go to the previous list of the sub-menu.

Where?
Where can the MOVE sub-menu be found?

Figure 14.4: Move Menu Tablet

Figure 14.5: REACH PDS Screen showing Move sub-menu
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•	 As you will open the REACH PDS, there in the menu bar you will find the DRAW Menu.

•	 As you will click on the Draw Menu (or use the shortcut key alt+D), a dropdown menu will appear

•	 In that, the tenth option will be the Move sub-menu.

OR

	 In the bottom-right corner when you click on the Back (8) in Figure 14.4, you will see Figure 14.6. From here you 
can access any of the sub-menu

Why?
Why is the MOVE sub-menu used?

This is used to move a Pattern, Internal, Tracing, Pattern Point, Tracing Point etc

How?
How to use the MOVE sub-menu? 

                                                     Figure 14.6: Draw Menu Tablet	

Figure 14.7: REACH PDS Screen showing the use of Move sub-menu.
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•	 Single-click on the Move option from Draw Menu.

•	 You will see a dialog box as shown in Figure 14.4 at Menu Tablet.

•	 Select the type of drawing to be moved through the dropdown (in this case, Internal) in the combo box.

•	 Select the direction where you want to move, length or angle at which you want to movie and click on Apply.

•	 Select the move parameter from the Menu Tablet.

•	 Using the cursor move the object to the new location.

	 Note: Moving of an object is context sensitive. The object clicked on will become the active selection 
automatically.

•	 If you want to align any two patterns at a certain point, Hold down the Ctrl Key; click on the desired point of 
one pattern and then drag it to the desired point on the second pattern.

15	Rotate piece
Shortcut:
Key: Ctrl + Tab or Alt + T + A

Toolbar:

What?
What are the various options/features available in the ROTATE sub-menu?

1	 Pattern- to rotate pattern pieces

2	 Selection- to select the tracing piece or a part of tracing piece and to rotate the piece.

3	 Tracing - to rotate the existing tracings

4	 Back- It is used to go to the previous list of the sub-menu.

Where?
Where can the ROTATE sub-menu be found?

Figure 15.1: Rotate Menu Tablet
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 Figure 15.2: REACH PDS Screen showing Rotate sub-menu

•	 As you will open the REACH PDS, there in the menu bar you will find the TOOLS Menu.

•	 As you will click on the Tools Menu (or use the shortcut key alt+T), a dropdown menu will appear

•	 In that, the tenth option will be the Rotate sub-menu.

OR

	 In the bottom-right corner when you click on the Back (4) in Figure 15.1, you will see Figure 15.3. From here you 
can access any of the sub-menu

Why?
Why is the ROTATE sub-menu used?

To rotate a pattern/selection/tracing.

How?
How to use the ROTATE sub-menu?

Figure 15.3: Tools menu tablet
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•	 Single-click on Rotate option from Tools menu.

•	 You will see a Menu Tablet with three options select any one.

•	 After selecting one option check the Angle and step angle box as per your requirement.

16	Measure
Shortcut:
Key: Shift + F9 or Alt + D + M
Toolbar:

What?
What are the various options/features available in the MEASURE sub-menu?

1	 Pattern segment - It is used to measure the pattern segment

2	 Trace segment - It is used to measure the trace segment

3	 Internal Segment - It is used to measure the internal segment

4	 Back - It is used to go to the previous list of the sub-menu.

Where?
Where can the MEASURE sub-menu be found? 

Figure 16.1: Measure Menu Tablet
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Figure 16.2: REACH PDS Screen showing Measure sub-menu

•	 As you will open the REACH PDS, there in the menu bar you will find the DRAW Menu.

•	 As you will click on the Draw Menu (or use the shortcut key alt+D), a dropdown menu will appear

•	 In that, the ninth option will be the Measure sub-menu.

OR

	 In the bottom-right corner when you click on the Back (4) in Figure 16.1, you will see Figure 16.3. From here you 
can access any of the sub-men

Why?
Why is the MEASURE sub-menu used?

It is used to measure the segment that is selected

How?
How to use the MEASURE sub-menu?

•	 Select the Measure sub-menu from the Draw menu

Figure 16.3: Draw menu tablet
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•	 Select the option related what you want to measure from the drop-down or from the menu tablet as shown in 
Figure 20.1

•	 Single click on any of the segment that you want to measure

•	 A dialog box will appear showing the measurements

17	Add Fullness
Shortcut:
Key: F7 or Alt + T + U

Toolbar:

What?
What are the various options/features available in the FULLNESS sub-menu?

1	 Apply- It is used to apply the changes mentioned in the list

2	 Depth- It is used to mention the depth of the fullness that is to be created

3	 Direction- It is used to mention the direction in which the fullness is to be created

4	 No of Cuts- It is used to mention the number of cuts that will be given to the fullness.

5	 Back- It is used to go to the previous list of the sub-menu.

Where?
Where can the FULLNESS sub-menu be found?

Figure 17.1: Fullness Menu Tablet
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Figure 17.2: REACH PDS Screen showing Fullness sub-menu

•	 As you will open the REACH PDS, there in the menu bar you will find the TOOLS Menu.

•	 As you will click on the Tools Menu (or use the shortcut key alt+T), a dropdown menu will appear

•	 In that, the fifth option will be the Fullness sub-menu.

OR

	 In the bottom-right corner when you click on the Back (5) in Figure 17.1, you will see Figure 17.3. From here you 
can access any of the sub-menu

Why?
Why is the FULLNESS sub-menu used?

To add fullness to the pattern that is being created.

How?
How to use the FULLNESS sub-menu? 

Figure 17.3: Tools menu tablet
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•	 Single click on fullness options from the tools menu

• 	 Input the depth of the slash

•	 Select the direction you want the fullness to be spread (Clockwise, Anticlockwise, or in both the directions)

•	 Click on apply

•	 Click the start point where you want the fullness to be incorporated

•	 Move the mouse to the end of the pattern you want the fullness to be incorporated. Click on the pattern 
segment.

•	 The fullness will be incorporated between the two points clicked.

18	Cut, Join, Build & Trace piece
a	 Cut Shortcut:
Key: Ctrl + X or Alt + E + T

Toolbar:   

Where?
Where can the DELETE sub-menu be found?

Figure 17.3
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Figure 18.1: REACH PDS Screen showing Delete sub-menu

•	 As you will open the REACH PDS, there in the menu bar you will find the EDIT Menu.

•	 As you will click on the Edit Menu (or use the shortcut key alt+E), a dropdown menu will appear

•	 In that, the fourth option will be the Delete sub-menu.

OR

In the bottom-right corner you will see Figure 18.2. From here you can access any of the sub-menu

Why?
Why is the DELETE sub-menu used?

It is used to delete anything other than a pattern like tracing or trace segment

How?
How to use the DELETE sub-menu?

Figure 18.2: Edit Menu Tablet
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Figure 18.3: REACH PDS Screen showing the use of Delete sub-menu

•	 Click on the Select icon from the toolbar or click on the Select sub-menu from the Edit menu
•	 Click on the option that you want to select
•	 Hover on the tracing & as it turns in red-green dotted line, click on that. That will be selected
•	 Click on the Delete icon or Delete sub-menu from the Edit Menu
b	 Join 
Shortcut:
Key: F8 or Alt + T + J

Toolbar: 

What?
What are the various options/features available in the JOIN sub-menu?
1	 All sizes- this option is used to join two pieces
2	 Back- It is used to go to the previous list of the sub-menu.
Where?
Where can the JOIN sub-menu be found?

Figure 18.4: Join Menu Tablet
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Figure 18.5: REACH PDS Screen showing Join sub-menu

•	 As you will open the REACH PDS, there in the menu bar you will find the TOOLS Menu.

•	 As you will click on the Tools Menu (or use the shortcut key alt+T), a dropdown menu will appear

•	 In that, the sixth option will be the Join sub-menu.

OR 

	 In the bottom-right corner when you click on the Back (2) in Figure 18.4, you will see Figure 18.6. From here you 
can access any of the sub-menu

Why?
Why is the JOIN sub-menu used?

To join two pieces to make a single piece

How?
How to use the JOIN sub-menu?

•	 Select two patterns from the pattern area/create two patterns that you want to join

•	 Single click on the All Sizes option in the Join sub-menu from Tools menu

•	 Single click on the point of the pattern segment in which you want to join the another pattern

Figure 18.6: Tools menu tablet
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•	 Move the cursor to the second point of the pattern segment of the first pattern

•	 Single click on the point of the pattern segment from the second pattern that you want to join.

•	 Move the cursor to the second point of the pattern segment of the second pattern

19	Fold piece
Shortcut:
Key: Ctrl + F3 or Alt + T + L

Toolbar: 

Where?

Where can the FOLD sub-menu be found?

•	 As you will open the REACH PDS, there in the menu bar you will find the TOOLS Menu.

•	 As you will click on the Tools Menu (or use the shortcut key alt+T), a dropdown menu will appear

•	 In that, the twelfth option will be the Fold sub-menu.

OR

Figure 19.1: REACH PDS Screen showing Fold sub-menu

Figure 19.2: Tools menu tablet
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In the menu tablet, you can navigate to Figure 18.2 & from there you can access the Fold option

Why?
Why is the FOLD sub-menu used?

To fold the patterns.

How?
How to use the FOLD sub-menu?

•	 Select the Pattern you want to fold.

•	 Click on the first point contour of the pattern segment and move the mouse to the second point of the contour.

•	 When the mouse reaches the second contour, the pattern will be folded between the two contours.

•	 Once the fold is as desired, click at the point.

•	 The pattern will be folded permanently. 

20	Insert Pleats
Shortcut:
Key: F6 or Alt + T + T

Toolbar:

Figure 19.3: REACH PDS Screen showing using Fold sub-menu
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Snippet_31C301EEF.idms

What?
What are the various options/features available in the PLEATS sub-menu?

1	 Knife- This option is used to create a KNIFE Pleat

2	 Box- This is used to create a BOX Pleat

3	 Back- It is used to go to the previous list of the sub-menu.

Where?
Where can the PLEATS sub-menu be found? 

Figure 20.1: Pleats Menu Tablet

Figure 20.2: REACH PDS Screen showing Pleats sub-menu
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•	 As you will open the REACH PDS, there in the menu bar you will find the TOOLS Menu.

•	 As you will click on the Tools Menu (or use the shortcut key alt+T), a dropdown menu will appear 

•	 In that, the fourth option will be the Pleats sub-menu.

OR

	 In the bottom-right corner when you click on the Back (3) in Figure 20.1 you will see Figure 20.3. From here you 
can access any of the sub-menu

Why?
Why is the PLEATS sub-menu used?

This option is used to create a knife and box pleat

How?
How to use the PLEATS sub-menu?

Click on this option and you will see a Dialog box as in Figure 25.1.

21	Add Fullness
Same as 21. Fullness

22 Insert Button Add Notch
a	 Button

Figure 20.3: Tools menu tablet

Figure 22.1: Button Menu Tablet
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What?
What are the various options/features available in the BUTTON sub-menu?

1	 Radius- It is used to specify the radius of the button hole

2	 Apply- It is used to apply the changes mentioned in the list

3	 Back- It is used to go to the previous list of the sub-menu.

Where?
Where can the BUTTON sub-menu be found?

	

•	 As you will open the REACH PDS, there in the menu bar you will find the DRAW Menu.

•	 As you will click on the Draw Menu (or use the shortcut key alt+D), a dropdown menu will appear

•	 In that, the fifth option will be the Others sub-menu.

•	 As you will hover on it, you will see different options

OR

Figure 22.2: REACH PDS Screen showing Button sub-menu

Figure 22.3: Others Menu Tablet
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	 In the bottom-right corner when you click on the Back (3) in Figure 22.2, you will see Figure 22.3. From here you 
can access any of the sub-menu
Why?
Why is the BUTTON sub-menu used?
It is used to make sure that buttons are placed on the same place so that it gives exact matching.
How?
How to use the BUTTON sub-menu?

•	 Single-click on Button option from the menu Draw/ Others.

•	 Single-click inside the pattern block so as to make a mark for the Button.

b	 Notch
Shortcut:
Key: Shift + F4 or Alt + D + N

Toolbar:

Figure 22.4: REACH PDS Screen showing using Button

Figure 22.5: Notch Menu Tablet
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What?
What are the various options/features available in the NOTCH sub-menu?

1	 V Notch- It is used to create a notch of V-shape.

2	 I Notch- It is used to create a notch of I-shape.

3	 U Notch- It is used to create a notch of U-shape.

4	 T Notch- It is used to create a notch of T-shape.

5	 Orient- It is used to orient the notch as per the direction

6	 Delete- It is used to delete any notch

7	 Back- It is used to go to the previous list of the sub-menu.

Where?
Where can the NOTCH sub-menu be found?

Figure 22.6: REACH PDS Screen showing Notch sub-menu

•	 As you will open the REACH PDS, there in the menu bar you will find the DRAW Menu.

•	 As you will click on the Draw Menu (or use the shortcut key alt+D), a dropdown menu will appear

•	 In that, the fourth option will be the Notch sub-menu.

OR
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Figure 22.7: Draw menu tablet

	 In the bottom-right corner when you click on the Back (7) in Figure 22.5, you will see Figure 22.7. From here you 
can access any of the sub-menu

How?
How to use the NOTCH sub-menu?

•	 Single-click on any type of notch options from menu Draw/ notch.

•	 When you click on notch type you will see that the menu Tablet changes as text box entry with asking values 
for depth and width.

•	 Enter the required value of width and length of the notch.

23	Align Points
Shortcut:
Key: Shift + F2

Toolbar:

Figure 23.1: Align Two Points Menu Tablet

What?
What are the various options/features available in the ALIGN TWO POINTS sub-menu?
1	 Apply- It is used to apply the changes mentioned in the list
2	 Horizontal- It is used to align two points horizontally
3	 Vertical- It is used to align two points vertically
4	 Angle- It is used to align two points at a specified angle

CITS : Apparel - Sewing Technology  - Exercise 5
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•	 As you will open the REACH PDS, there in the menu bar you will find the TOOLS Menu.

•	 As you will click on the Tools Menu (or use the shortcut key alt+T), a dropdown menu will appear

•	 In that, the eleventh option will be the Align Two Points sub-menu.

OR

5	 Align on Internals- It is used to align the points on an internal
6	 Back- It is used to go to the previous list of the sub-menu.
Where?
Where can the ALIGN TWO POINTS sub-menu be found?

Figure 23.2:  REACH PDS Screen showing Align Two Points sub-menu

Figure 23.3: Tools menu tablet

	 In the bottom-right corner when you click on the Back (6) in Figure 23.1, you will see Figure 23.3. From here you 
can access any of the sub-menu

Why?
Why is the ALIGN TWO POINTS sub-menu used?
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Figure 23.4: REACH PDS Screen showing using Align two points

We can align a pattern based on two points.

How?
How to use the ALIGN TWO POINTS sub-menu? 

•	 Single click on the Align Two Points from the Tools menu

•	 From the menu tablet, select the direction in which you want to align the points
•	 Single click on a point of the side which you want to align in the pattern & drag the mouse to the another point 

of the segment. Click again
•	 The pattern will be aligned on the basis of the selected line

Note: The aligned one will be a tracing, which will be a copy of the pattern.

24	Circle, Arc & Wave
Shortcut:
Key: Shift + F2 or Alt + D + C

Toolbar:

Figure 24.1: Curve Menu Tablet
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What?
What are the various options/features available in the CURVE sub-menu?

1	 Arc- It is used to create an arc

2	 3 Point Bezier- It is used to create a bezier curve by selecting the starting & ending points in the screen & then 
adjust it according to the shape of the curve required

3	 4 Point Bezier- It is used to create a bezier curve by selecting the 3 points on the screen & then adjust it 
according to the shape of the curve required

4	 Spline- It is used to create a spline curve by selecting point by point, creating the shape in that process

5	 Intersect- It is used to intersect two independent lines

6	 Circle- It is used to create a circle

7	 Back- It is used to go to the previous list of the sub-menu.

Where?
Where can the CURVE sub-menu be found? 

Figure 24.2: REACH PDS Screen showing Curve sub-menu

•	 As you will open the REACH PDS, there in the menu bar you will find the DRAW Menu.

•	 As you will click on the Draw Menu (or use the shortcut key alt+D), a dropdown menu will appear

•	 In that, the second option will be the Curve sub-menu

OR
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Figure 24.3: Draw menu tablet

	 In the bottom-right corner when you click on the Back (7) in Figure 24.1, you will see Figure 24.3. From here you 
can access any of the sub-menu

Why?
Why is the CURVE sub-menu used?

It is used to draw all curved lines

How?
How to use the CURVE sub-menu?

•	 Select the Curve sub-menu from the Draw Menu

•	 Select the type of curve that you want to make

-	 If you select any of the curve except Circle, you can directly start making the curve

-	 If you select Circle, then specify the radius (optional) of the circle that you want to make

•	 Make the curve by selecting the stating & ending point of the curve

25	Trace & Trim
Shortcut:
Key: F10 or Alt + T + I

Toolbar:

Figure 25.1: Split Menu Tablet
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What?
What are the various options/features available in the SPLIT sub-menu?

1	 All sizes- to cut the piece equally for all sizes

2	 Proportional- to cut the pieces proportionally for all sizes

3	 Back- It is used to go to the previous list of the sub-menu.

Where?
Where can the SPLIT sub-menu be found?

Figure 25.2: REACH PDS Screen showing Split sub-menu

•	 As you will open the REACH PDS, there in the menu bar you will find the TOOLS Menu.
•	 As you will click on the Tools Menu (or use the shortcut key alt+T), a dropdown menu will appear
•	 In that, the eighth option will be the Split sub-menu.
OR

Figure 25.3: Tools menu tablet
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	 In the bottom-right corner when you click on the Back (3) in Figure 25.1, you will see Figure 25.3. From here you 
can access any of the sub-menu
Why?
Why is the SPLIT sub-menu used?
To cut the pattern as a two parts
How?
How to use the SPLIT sub-menu?
•	 Select the pattern you want to cut from the piece table.
•	 Using any of the drawing tools, draw a tracing across the contour of the pattern into the required shape of the 

pattern to cut.
•	 Single-click on the option Split from the Tools menu.
•	 Select the sub option.
•	 To Split patterns there are options displayed in Menu Tablet. You can choose anyone of them before you split 

the pieces.
26	Extend, Join & split Contour
b	 Join
Same as 18. b) Join
c	 Split
Same as 25. Split 
27	Practice of Cutting, Joining, Creating lines
a	 Cutting (Delete)
Same as 3. Delete
b	 Join
Same as 18 b) Join
c	 Lines 
Shortcut:
Key: Shift + F1 or Alt + D + L
Toolbar:

Figure 27.1: Line Menu Tablet
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What?
What are the various options/features available in the LINE sub-menu?
1	 Normal- It is used to draw a line
2	 Horizontal- It is used to draw a horizontal line
3	 Vertical- It is used to draw a vertical line
4	 Parallel- It is used to create a parallel line corresponding to a selected line
5	 Perpendicular- It is used to create a perpendicular line corresponding to a selected line
6	 Intersect - It is used to intersect two independent lines
7	 Trim - It is used to cut already intersected lines to form another shape
8	 Rectangle- It is used to create a rectangle
9	 Back- It is used to go to the previous list of the sub-menu.
Where?
Where can the LINE sub-menu be found? 

Figure 27.2: REACH PDS Screen showing Line sub-menu

•	 As you will open the REACH PDS, there in the menu bar you will find the DRAW Menu.

•	 As you will click on the Draw Menu (or use the shortcut key alt+D), a dropdown menu will appear

•	 In that, the first option will be the Line sub-menu.

OR
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EXERCISE 6 : Familiarize with menu & command 

Refer the Exercise No.05

	 In the bottom-right corner when you click on the Back (9) in Figure 27.1, you will see Figure 27.3. From here you 
can access any of the sub-menu

Why?
Why is the LINE sub-menu used?

To draw a tracing line using line commands

How?
How to use the LINE sub-menu?

•	 Select the Line sub-menu from the Draw Menu

•	 Select the type of line that you want to make

-	 If you select a Normal, Horizontal or Vertical type of line then specify the length (optional) of the line that 
you want to make

-	 If you select Perpendicular or Parallel then select a line whose corresponding you want to make a 
perpendicular or parallel line & specify the length (optional) of the line that you want to make

-	 If you select Intersect or Trim then select the starting & ending points of 2 lines that you want to intersect or 
trim

-	 If you select Rectangle then specify the breadth & height (optional) of the rectangle that you want to make

•	 Make the line by first putting the starting point & moving 

Figure 27.3
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Objectives

EXERCISE 7 : Draft Children Upper Bodice Block 

At the end of this exercise you shall be able to
•	 drafting of children Bodice block.

Tools/Materials
•	 Computer with pattern making software (lastest version)		  - 1No. 		
•	 Measurement chart							      - 1No.	

Requirements

Procedure
Step 1 : Measurement of basic child shirt

Step 2 : Create new folder named child shirt on the desktop
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Step 3 : Double click on reach pds icon to open

Step 4 : Reach pds opens

Step 5 : Click on new sub-menu in the piece menu

CITS : Apparel - Sewing Technology  - Exercise 7
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Step 6 : Click on new sub-menu in the piece menu

Step 7 : Click on style in the right corner

Step 8 : In the create style dialog prompt, click yes

CITS : Apparel - Sewing Technology  - Exercise 7
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Step 9 : Select child shirt folder on the desktop

Step 10 : Click on the setup menu and then size sub-menu

Step 11 : Enter the size as 4-year in the right corner an click on apply to create sizes
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Step 12 : Click on setup menu and then unit sub-menu and click on cms

Step 13 : Click on setup menu and then click on style sub-menu

Step 14 : Click on setup menu and then click on style sub-menu

CITS : Apparel - Sewing Technology  - Exercise 7
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Step 15 : Click on draw menu and then click on lines sub-menu

Step 16 : Click on the rectangle sub-sub-menu in the right corner or from the dropdown

Step 17 : Enter the measurements of ½ chest and body length as the breath and length respectively and click 
on apply
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Step 18 : Click on the screen and then click again to draw the rectangle

Step 19 : Click on the zoom in icon from the tool bar to zoom on top corner point

Step 20 : Click on the draw menu, line sub-menu, horizontal sub-sub- menu
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Step 21 : Enter the neck width measurements (16/2=8 cm) in the bottom right corner

Step 22 : Apply the measurement on the width of the neck

Step 23 : Click on the draw menu, line sub-menu, vertical sub-sub- menu
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Step 24 : Enter the back neck measurements (4/2=2 cm) in the bottom right corner

Step 25 : Apply the measurement on the length of the neck

Step 26 : Click on the draw menu, line sub-menu, vertical sub-sub- menu
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Step 27 : Enter the measurement of front drop neck (2+4=6 cm) in the bottom right corner and click on apply

Step 28 : Click on the draw menu, curve sub-menu and 4 point bezier sub-sub-menu

Step 29 : Draw back neck by joining the neck width and drop neck
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Step 30 : Click on the draw menu, curve sub-menu and 4 point bezier sub-sub-menu

Step 31 : Draw front neck by joining the neck width and the front drop neck 

Step 32 : Click on the draw menu, insert point sub-menu and click on the in-tracing sub-sub-menu
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Step 33 : Enter shoulder measurement in the length in the bottom right corner and click on the horizontal line of 
the tracing to insert the point

Step 34 : Click on the draw menu, lines sub-menu and vertical sub- sub-menu

Step 35 : Enter the shoulder drop measurement and click on the shoulder point to apply the measurement
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Step 36 : Click on the draw menu, line sub-menu, normal sub-sub- menu

Step 37 : Join the joint neck point to drop shoulder point by clicking on each of the points

Step 38 : Click on the zoom out icon from the tool bar
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Step 39 : Click on the draw menu, insert point sub-menu and click on the in-tracing sub-sub-menu

Step 40 : Enter ½ armhole measurement in the length in the bottom right corner and click on the vertical line of 
the tracing to insert the point

Step 41 : Click on the draw menu, line sub-menu, normal sub-sub- menu
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Step 42 : Join the shoulder drop to armhole point by clicking on each of the points

Step 43 : Click on the draw menu, curve sub-menu and 4 point bezier sub-sub-menu

Step 44: Draw a 4 point bezier from shoulder drop to armhole point for armhole shape
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Step 45 : Click on the select icon from the tool bar. click to start selecting the area and drag to cover the area to 
be selected. click again to finish selecting

Step 46 : Click on cut/delete icon from the toolbar to delete the selection

Step 47 : Click on the draw menu, line sub-menu, normal sub-sub- menu
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Step 48 : Join the front neck, back neck to bottom line

Step 49 : Join armhole point to bottom point using the normal line

Step 50 : Click on the draw menu, extract pattern and then largest
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Step 51: Enter the name of the pattern as “back ct-1” in the bottom right corner and click on apply

Step 52 : Move the mouse to the tracing with the back till it turn dotted yellow

Step 53 : Click on it to create the pattern
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Step 54 : Click on the draw menu, extract pattern and then largest

Step 55 : Enter the name of the pattern as “front ct-1” in the bottom right corner and click on apply

Step 56 : Move the mouse to the tracing with the back till it turn dotted yellow
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Step 57 : Click on it to create the pattern

Step 58 : Click on move icon from the toolbar to move the pattern

Step 59 : Select pattern from the dropdown in the bottom right corner, select anywhere radio button and click on 
apply
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Step 60 : Move the front and back pattern and press ctrl+s to save

Step 61 : Click on the draw menu, line sub-menu, normal sub-sub- menu

Step 62 : Click on the piece menu, then new sub-menu. in the clear all tracing prompt, click yes
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Step 63 : Click on move icon from the toolbar to move the pattern

Step 64 : Select pattern pt from the dropdown in the bottom right corner, select length as 3cm and click on apply. 
click on the point

Step 65 : Click on the draw menu, curve sub-menu and 4 point bezier sub-sub-menu. draw a bezier at the bottom 
points

CITS : Apparel - Sewing Technology  - Exercise 7 CITS : Apparel - Sewing Technology  - Exercise 7

© NIMI 

NOT TO BE REPUBLISHED



122

SEWING TECHNOLOGY - CITS

Step 66 : Click on move icon from the toolbar to move the pattern

Step 67 : Select pattern pt from the dropdown in the bottom right corner, select length as 1cm and click on apply. 
click on the point

Step 68 : Click on the draw menu, curve sub-menu and 4 point bezier sub-sub-menu. draw a bezier at the bottom 
points
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Step 69 : Click on the flip icon from the toolbar and click on the back ct-1 pattern

Step 70 : Move the back ct-1 pattern & front ct-1 pattern together

Step 71: click on the draw menu, measure sub-menu
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Step 72 : click on shoulder point to armhole point to measure the length

Step 73 : note the armhole measurement as 17 cm

Step 74 : click on the draw menu, line sub-menu, rectangle sub-sub- menu. enter the measurements of bottom 
width (34/2=17 cm) and sleeve length (41 cm) as the breadth and length and click on apply. click on the screen 
and then click again to draw the rectangle
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Step 75 : Click on the draw menu, lines sub-menu and click on the on vertical. enter the length as 5 cm and click 
on apply. click on the right-side point draw a vertical line

Step 76 : Click on the draw menu, curve sub-menu and 4 point bezier sub-sub-menu. draw a bezier from the 
center point to drop point shape curve

Step 77 : Click on the select icon from the tool bar. click to start selecting the area and drag to cover the area to 
be selected. click again to finish selecting
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Step 78 : Click on cut/delete icon from the toolbar to delete the selection

Step 79 : Click on the draw menu, extract pattern and then largest. enter the name of the pattern as “sleeve ct-2” 
in the bottom right corner and click on apply

Step 80 : Click on the tracing line to create the sleeve pattern
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Step 81 : Click on the piece menu, then new sub-menu. in the clear all tracing prompt, click yes

Step 82 : Click on the piece menu, then open sub-menu

Step 83 : Click ctrl+s to save all the patterns and close
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Objectives

EXERCISE 8 : Children Lower Body block

At the end of this exercise you shall be able to
•	 draft of children trouser block

Tools/Materials
•	 Computer with pattern making software (latest version)	 - 1 No.		

Requirements

Procedure
Step 1 : Measurement of basic child trousers

Step 2: Create new folder named child trousers on the
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	 Step 3: Double click on reach PDS icon to open

	 Step 4: Reach PDS open

	 Step 5: Click on piece menu from the menu bar
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	 Step 6: Click on new sub menu in the piece menu

	 Step 7: Click on style in the right corner

	 Step 8: In the create style dialog prompt, click yes
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	 Step 9: Select child trousers folder on the desktop

	 Step 10: Click on the setup menu and then size sub menu

	 Step 11: Click on the setup menu and then size sub menu
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	 Step 12: Click on setup menu and then unit sub-menu and click on CM

	 Step 13: Click on draw menu and then click on lines sub menu

	 Step 14: Click on the rectangle sub menu in the right corner or from the dropdown 
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	 Step 15: Breath and length and click on apply

	 Step 16: Click on the screen and then click again to draw the rectangle

	 Step 17: Click on the tracing line on reach PDS
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	 Step 18: Click on the zoom icon   from the tool bar to zoom on top corner point

	 Step 19: Sub menu

	 Step 20: Enter the waist measurements (58/4 = 14.5 cm) in the bottom right corner
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	 Step 21: Apply the measurement on the width of the waist

	 Step 22: Click on the draw menu, line sub menu, normal sub menu

	 Step 23: Apply the back side measurement
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	 Step 24: Click on the draw menu, curve sub menu and 4 point bezier sub menu

	 Step 25: Click top to down point

	 Step 26: Click on the tracing to curves for the back side
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	 Step 27: Click on the draw menu, Line sub menu, Normal sub menu

	 Step 28: Apply hip measurement

	 Step 29: Click on the draw menu, curve sub menu, 4 point bezier in the curves sub menu to get a hip shape
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	 Step 30: Measure ½ waist as 14.5/2=7.25. apply to center marketing

	 Step 31: Click on the draw menu, Line sub menu, Vertical sub menu

	 Step 32: Enter the hem width measurement (32/2=16 cm) in the bottom right corner. click on the screen and click 
again to draw the vertical line
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	 Step 33: Click on draw menu, curve sub-menu and 4 point bezier sub-sub-menu

	 Step 34: Join hip line to hem line

	 Step 35: Click on the select icon   from the tool bar. click on the tracing area in the bottom right corner
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	 Step 36: Click to start selecting the area and drag to cover the area to be selected. click again to finish selecting

	 Step 37: Click on cut/delete icon  from the toolbar to delete the selection

	 Step 38: Click on the draw menu, extract pattern and then largest
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	 Step 39: Enter the name of the pattern as “back” in the bottom right corner and click on apply

	 Step 40: Making to front pattern -1 cm to all part move to front rise -2.5 cm move down

	 Step 41: Click On The Draw Menu, Extract Pattern And Then Largest
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	 Step 42: Enter the name of the pattern as “front” in the bottom right corner and click on apply

	 Step 43: On the in-pattern sub-menu

	 Step 44: Enter 2 in the parts in the bottom right corner and click on the pattern to insert the point in the center
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	 Step 45: Click on the tool menu, then create darts sub-menu

	 Step 46: Insert the measurements, select clockwise direction and click on apply

	 Step 47: Front and back pattern of block set for children is ready
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	 Step 48: Click ctrl +s to save all the patterns and clse
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Objectives

EXERCISE 9 : Drafting Ladies bodice block & trouser 		
	 block 

At the end of this exercise you shall be able to:
•	 drafting of Ladies bodice block
•	 drafting of Ladies trouser block

Tools/Materials
•	 Computer with pattern making software (latest version)	 - 1 No.	
•	 Measurement chart						     - 1 No.

Requirements

Procedure
TASK 1: Drafting of Ladies bodice block
Step 1 : Measurement of basic ladies bodice
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Step 3 :
Double click on reach pds icon to open

Step 2 :
Create new folder named ladies bodice on the desktop
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Step 4 :
Reach Pds opens

Step 5 :
Click on piece menu from the menu bar
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Step 6 :
Click on new sub-menu in the piece menu

Step 7 :
Click on style in the right corner.
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Step 8 :
In the create style dialog prompt, click yes

Step 9 :
Select ladies bodice folder on the desktop
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Step 10 :
Click on the setup menu and then size sub-menu

Step 11 :
Enter the skirt size from the measurements given in the right corner to create sizes
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Step 12 :
Click on setup menu and then unit sub-menu and click on cms

Step 13 :
Click on setup menu and then click on style sub-menu
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Step 14 :
Select the base size as m from the dropdown in the bottom right corner

Step 15 :
Click on draw menu and then click on lines sub-menu
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Step 16 : 
Click on the rectangle sub-sub-menu in the right corner or from the dropdown

Step 17 :
Enter the measurements of ½ chest and body length as the breath and length respectively and click on apply
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Step 18 :
Click on the screen and then click again to draw the rectangle.

Step 19 :
Click on the Zoom In Icon	

From the tool bar to Zoom on Top Corner Point
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Step 20  :
Click on the Draw Menu, Line Sub-Menu, Horizontal Sub-Sub-Menu.

Step 21 :
Enter the neck width measurements in the bottom right corner
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Step 22 :
Apply the measurement on the width of the neck.

Step 23 :
Click on the Draw Menu, Line Sub-Menu, Vertical Sub-Sub-Menu.
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Step 24 :
Enter the back neck drop measurement in the bottom right corner

Step 25 :
Apply the measurement on the length of the neck.
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Step 26 :
Click on the Draw Menu, Line Sub-Menu, Vertical Sub-Sub-Menu.

Step 27 :
Enter the front neck drop measurement in the bottom right corner
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Step 28 : 
Apply the measurement on the length of the neck

Step 29 :
Click on the Draw Menu, Curve Sub-Menu and 4 Point Bezier Sub-Sub-Menu.
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Step 30 :
Draw back neck by joining the neck width and back neck drop

Step 31 :
Click on the Draw Menu, Curve Sub-Menu and 4 Point Bezier Sub-Sub-Menu.
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Step 32 : 
Draw The front neck by joining the neck width and front neck drop

Step 33 :

Click on the Draw Menu, Line Sub-Menu, Horizontal Sub-Sub-Menu.
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Step 34 :
Enter the shoulder measurement in the bottom right corner

Step 35 :
Apply the measurement on the width of the neck.
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Step 36 :  Click on the draw menu, line sub-menu, vertical sub-sub-menu

Step 37 : Enter the shoulder drop measurement in the bottom right corner
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Step 38 : Apply the measurement on the width of the neck

Step 39 : Click on the draw menu, line sub-menu, normal sub-sub-menu
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Step 40 : Join the neck point to shoulder drop point

Step 41 : Click on the draw menu, line sub-menu, normal sub-sub-menu
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Step 42 : Enter the ½ armhole measurement in the bottom right corner and click on apply. draw the line from the 
shoulder drop to the length

Step 43 : Click on the draw menu, curve sub-menu and 4 point bezier sub-sub-menu
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Step 44 : Draw armhole shape by joining the shoulder drop and armhole

Step 45  : Click on the select icon              from the tool bar. click to start selecting the area and drag to cover the 
area to be selected. click again to finish selecting.
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Step 46 :  Click on cut/delete icon             from the toolbar to delete the selection

Step 47 : Click on the draw menu, line sub-menu, normal sub-sub-menu
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Step 48  :  Join the front neck, back neck to bottom line

Step 49  : Click on the draw menu, line sub-menu, normal sub-sub-menu
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Step 50  : Join the armhole point to bottom point

Step 51  : Click on the draw menu, extract pattern and then largest

CITS : Apparel - Sewing Technology  - Exercise 9

© NIMI 

NOT TO BE REPUBLISHED



171

SEWING TECHNOLOGY - CITS

Step 52  : Enter the name of the pattern as “back ct-1” in the bottom right corner and click on apply. move the 
mouse to the tracing with the back till it turn dotted yellow

Step 53  : Click on it to create the pattern
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Step 55  : Enter the name of the pattern as “front ct-1” in the bottom right corner for the front neck drop and click 
on apply. click on it to create the pattern

Step 54  : Click on the draw menu, extract pattern and then largest
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Step 57  :  Select pattern from the dropdown in the bottom right corner, select anywhere radio button and click 
on apply

Step 56  : Click on move icon            from the toolbar to move the pattern
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Step 58  : Move the front ct-1 and back ct-1 pattern and click ctrl+s to save

Step 59  : Click on the piece menu, then new sub-menu. in the clear all tracing prompt, click yes

Step 60  : Click on the tools menu, grade sub-menu and select auto from the dropdown to cancel all grading 
points
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Step 61  : Enter the name of the pattern as “front ct-1” in the bottom right corner and click on apply

Step 62  : Click on shoulder point to armhole point to measure the length of any of the front or back pattern

Step 63  : Click on the draw menu, line sub-menu, rectangle sub-sub-menu. enter the measurements of armhole 
and length as the breadth and length and click on apply. click on the screen and then click again to draw the 
rectangle
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Step 64  : Click on the draw menu, lines sub-menu and click on the on vertical. enter the length as 3 cm and click 
on apply. click on the right-side point draw a vertical line

Step 65 : Click on the draw menu, curve sub-menu and 4 point bezier sub-sub-menu. draw a bezier from one 
point to another

Step 66 : Click on the select icon from the tool bar. click to  start selecting the area and  drag    to  cover the area 
to be selected. click again to finish  selecting
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Step 67 : Click on cut/delete icon from the toolbar to delete the selection.

Step 69 : Click on the piece menu, then open sub-menu

Step 68 : Click on the draw menu, extract pattern and then largest. enter the name of the pattern as “sleeve ct-2” 
in the bottom right corner and click on apply
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Step 70 : Click On The Tools Menu, Then Create Darts Sub-Menu. Add Darts In The Sleeve Ct-2.

Step 72 : Click on the tools menu, then create darts sub-menu. add darts on the top in the front ct- 1 pattern.

Step 71 : Click on move icon	   from the toolbar to move the pattern pt. select pattern pt from the dropdown, select 
anywhere radio button and click on apply. click on the pattern pt and move the point above to create sleeve bottom 
shape.
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Step 73 : Click on the tools menu, then create darts sub-menu. add darts on the bottom in the front ct-1 pattern

Step 74 : Click on the tools menu, then create darts sub-menu. add darts on the top in the back ct-1 pattern

Step 75 : Click on the tools menu, then create darts sub-menu. add 2 darts on the bottom in the back ct-1 pattern

CITS : Apparel - Sewing Technology  - Exercise 9 CITS : Apparel - Sewing Technology  - Exercise 9

© NIMI 

NOT TO BE REPUBLISHED



180

SEWING TECHNOLOGY - CITS

Step 76 : Click ctrl+s to save all the patterns and close

TASK 2: Drafting Trousers block
Step 1 : Measurement of basic ladies trousers
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Step 2 : Create new folder named ladies trousers on the desktop

Step 3 : Double click on reach pds icon to open
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Step 5 : Click on piece menu from the menu bar

Step 6 : Click on new sub-menu in the piece menu

Step 4 : Reach pds opens
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Step 7 : Click on style in the right corner.

Step 8 : In the create style dialog prompt, click yes
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Step 10 : Click on the setup menu and then size sub-menu

Step 9 : Select ladies trousers folder on the desktop
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Step 11 : Enter the trousers size from the measurements given in the right corner to create sizes

Step 12 : Click on setup menu and then unit sub-menu and click on cms
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Step 14 : Click on draw menu and then click on lines sub-menu

Step 13 : Click on setup menu and then click on style sub-menu
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Step 15 : Click on the rectangle sub-sub-menu in the right corner or from the dropdown

Step 16 : Enter the measurements of front rise and out seam length as the breath and length respectively and 
click on apply
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Step 18 : Click on the zoom in icon  from the tool bar to zoom on top corner point

Step 17 : Click on the screen and then click again to draw the rectangle.
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Step 19 : Click on the draw menu, line sub-menu, horizontal sub-sub-menu.

Step 20 : Enter the waist measurements (40/2=20 cms) in the bottom right corner

Step 21: Apply the measurement on the width of the waist.
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Step 22 : Click on the draw menu, line sub-menu, vertical sub-sub-menu.

Step 23 : Enter the back rise measurements in the bottom right corner
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Step 24 : Apply the measurement on the length of the waist.

Step 25 : Click on the draw menu, line sub-menu, normal sub-sub-menu.
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Step 27 : Click on the draw menu, curve sub-menu and 4 point bezier sub-sub-menu.

Step 26 : Join the back rise and the waist
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Step 28 : Draw the curve on the line joining the waist and back rise.

Step 29 : Click on the draw menu, line sub-menu, normal sub-sub-menu.
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Step 31 : Apply the measurement on the horizontal and vertical direction from the bezier point.

Step 30 : Enter the hip measurements in the bottom right corner
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Step 32 : Click on the draw menu, line sub-menu, horizontal sub-sub-menu.

Step 33 : Join the back rise to the other end of the length.
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Step 34 : Click on the draw menu, curve sub-menu and 4 point bezier sub-sub-menu.

Step 35 : Draw a bezier passing through the points along the length to get a hip shape.
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Step 36 : Click on the draw menu, line sub-menu, horizontal sub-sub-menu.

Step 37 : Enter the 1/4 waist (40/4=10 cms) measurements in the bottom right corner and apply the measurements 
along the breadth.
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Step 39 : Join the ¼ waist measurement to the bottom to apply the center marking

Step 38 : Click on the draw menu, line sub-menu, vertical sub-sub-menu.

CITS : Apparel - Sewing Technology  - Exercise 9

© NIMI 

NOT TO BE REPUBLISHED



199

SEWING TECHNOLOGY - CITS

Step 40 : Click on the draw menu, line sub-menu, horizontal sub-sub-menu.

Step 41 : Enter the hem width measurements in the bottom right corner and apply it from the central marking
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Step 42 : Click on the draw menu, curve sub-menu and 4 point bezier sub-sub-menu.

Step 43 : Join the hip line to hem line using the 4 point bezier
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Step 44 : Click on the select icon  from the tool bar. Click on the tracing area in the bottom right corner.

Step 45 : Click on cut/delete icon  from the toolbar to delete the selection.
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Step 46 : Click on the draw menu, extract pattern and then largest.

Step 47 : Enter the name of the pattern as “back ct-2” in the bottom right corner and click on apply. Click on the 
tracing to create a pattern
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Step 48 : Click on move icon  from the toolbar to move the pattern

Step 49 : Enter the length as 2.5 cm, select the vertical radio button, select pattern pt from the dropdown and click 
on apply in bottom right corner. Click on the back ct-2 point to move.
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Step 50 : Click on move icon  from the toolbar to move the pattern

Step 51 : For the front pattern, enter the length as -1 to move all the points and -2.5 Cm to move the front rise 
point, select the vertical radio button, select tracing pt from the dropdown and click on apply in bottom right corner. 
Click on all the points to move down.
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Step 52 : Click on the draw menu, extract pattern and then largest.

Step 53 : Enter the name of the pattern as “front ct-2” in the bottom right corner and click on apply. Click on tracing 
to create it a pattern.
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Step 54 : Click on the draw menu, insert point sub-menu and click on the in-pattern sub-sub-menu.

Step 55 : Select the center radio button in the bottom right corner and click on apply. Click on the line of back ct-2 
to insert a point in the center
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Step 56 : Click on the tools menu, then create darts sub-menu.

Step 57 : Insert the measurements, select clockwise direction and click on apply. Click on the center point to 
create a dart.
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Step 58 : Front and back pattern for ladies is ready

Step 59 : Click ctrl+s to save all the patterns and close

CITS : Apparel - Sewing Technology  - Exercise 9

© NIMI 

NOT TO BE REPUBLISHED



209

SEWING TECHNOLOGY - CITS

Objectives

EXERCISE 10 : Digitizing of Blocks

At the end of this exercise you shall be able to
•	 digitizing the Blocks

Tools/Materials
•	 Digitizing magnetic board 		 - 1No.
•	 Computer with pattern making 		

software (Latest version)			  - 1No.

Requirements

Procedure
Step 1 : Using a Digitizer to digitize apparel patterns

Place the patterns that need to be digitized on REACH 
Digitizing Board using the button magnets provided along 
with the REACH Digitizing Board.

Ensure that enough button magnets are used so that the 
patterns don’t move.

Click images of the patterns on REACH Digitizing Board 
using the camera provided

Ensure that the entire REACH Digitizing Board is captured 
with all the patterns on it.

•	 Camera	 - 1No.
•	 Camera Stand	 - 1No.

Fig 1

Fig 2

Step 2 : Connect the camera to the computer on which REACH PDS is installed (Fig 2)
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Fig 3 Fig 4

Fig 5

Step 3 : 	Import the pattern images into REACH PDS software. Open the pattern images in REACH PDS 		
       	 (Fig 3 & 4)

Step 4 : Now you can work on the patterns on REACH PDS (Fig 5)
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Design with Darts
Objectives : At the end of this exercise you shall be able to
•	 designing with Diamond darts
•	 designing with V darts.

Tools/Materials
•	 Computer with pattern making software (Latest Version)  - 1 No. 			    	

Requirements

Procedure
TASK 1 : Designing with Darts - Diamond Darts
Step 1 :  How to insert Diamond darts

First we need to mark dart placements by using points.

Select other markings

Step 2 : Select Point at right bottom corner of the screen.
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Step 3 : Now you can give values for dart marking at left bottom corner of the screen

Step 4 : For example if I want to start dart from -3 inches above the bottom hem, give -3” value in vertical box.

Step 5 : Now give a left click on the bottom hem point from where you need to insert a dart.
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	 Step 6 : A point will appear exactly 3 inches above the bottom hem point

Step 7 : For example if our dart length is 6”, we need to take -3”in vertical column and repeat it twice to get 6” 		
	       length with center point.

Step 8 : 	From center point we need to mark dart width, for that give value in horizontal box ie.1” for right and 		
	 repeat -1” for left side point.
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Step 9 : Now select Draw Internals.

Step 10 : Select Internal Lines.
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Step 11 : Now join all the points forming a Diamond dart.

Step 12 : Repeat it for other side.

Step 13 : If you close the dart while stitching you will get the curved shape at side seam for proper fitting at waist.
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TASK 2 : Designing with Darts - V Darts
Inserting V shape dart in skirt.

Step 1 : V shape dart will be added in back pattern of a skirt for perfect fitting

	 Select Create Darts tool on Tool bar

Step 2 : Select Insert
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Step 3 : Select Anti-clockwise

Step 4 : Input the values in the column, for example Dart depth- 4inch, Width-1inch and Radius-0.05

Step 5 : Click on Apply
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Step 6 : To insert a dart on a pattern first one left click on the point, second left click on the pattern in anti- 		
	 clockwise direction and 2 left clicks inside the pattern.

Step 7 : A dart with 4inches depth and 1 inch width will be inserted.
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Insert Style Lines
Objectives : At the end of this exercise you shall be able to
•	 insert of princess armhole styleline
•	 insert of princess shoulder styleline.

Tools/Materials
•	 Computer with pattern Making software (Latest version)   - 1 No.
•	 Bodice Block   

Requirements

TASK 1 :  Princess Armhole Styleline

Step 1 : 	Creating ladies block and cutting princess panels from armhole

	 Select Draw line from tool bar and click on vertical from bottom right corner

Procedure
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Step 2 : Give value of 24 inches and select length, draw a vertical line on the screen by giving one left click 		
	 drag the mouse downwards and one more left click

Step 3 : Select horizontal line click on length and give value of 7.5” for shoulder line and draw the horizontal line 	
	 from top point of vertical line
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Step 4 : Give value of 9” in horizontal and draw a bottom line

Step 5 : For bust placement we need a marking on vertical line for that select other markings and select point, 		
	 now on the left-hand bottom give Y or vertical value of 10” and give a left click on top point of vertical 		
	 line, you can see a point will appear exactly at 10” on the vertical line
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Step 6 : Draw line and select horizontal of 10” for bust line

Step 7 : Select other markings and clock on point, now give value in Y box of 3” and click from top point

	 Repeat the same in X direction with 3”
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Step 8 : Give 1.5” in Y box and click at shoulder point for shoulder slope

Step 9 : Now join all points with lines and curves
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Step 10 : 	Now extract the pattern by selecting and select largest from right bottom corner, give name as Front, 	
	 now keep cursor on the pattern and see all the pattern lines need to be selected

Step 11 : Lift click and your pattern will be extracted
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Step 12 : Delete all the tracing lines with select tool and delete selection tool

Step 13 : Select Open a pattern and select all sizes from right bottom to open the pattern , now give a left click 	
	 on the center line to open the pattern
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Step 15 : Draw a curve defining the princess line from armhole to bottom, the tracing line should be touching or 	
	 it should be crossing over the pattern line

Step 14 : To cut princess panel from armhole first we need to draw a tracing curve on the pattern where we 		
	 need to cut the panel

	 For this select Draw curve and select 3 point bezier
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Step 16 : Now select cut a pattern tool and all sizes and give piece name as panel 1, now keep cursor on the 		
	 left panel and give left click , you can see a new pattern had been extracted .

Step 17 : Press undo to get the same tracing lines back

	 Repeat it for right side panel naming panel 2 and center body as front
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Step 18 : Now you can see all 3 panels are separated and you can cut and stitch them together to form 		
	 princess line from armhole to bottom.

Step 1 : Creating ladies block and cutting princess panels from shoulder seam

	 Select Draw line from tool bar and click on vertical from bottom right corner

TASK 2 : Princess Shoulder Styleline
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Step 2 : Give value of 24 inches and select length, draw a vertical line on the screen by giving one left click 		
	 drag the mouse downwards and one more left click

Step 3 : Select horizontal line click on length and give value of 7.5” for shoulder line and draw the horizontal line 	
	 from top point of vertical line
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Step 4 : Give value of 9” in horizontal and draw a bottom line

Step 5 : For bust placement we need a marking on vertical line for that select Other markings and select point, 	
	 now on the left hand bottom give Y or vertical value of 10” and give a left click on top point of vertical 		
	 line, you can see a point will appear exactly at 10” on the vertical line
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Step 6 : Draw line and select horizontal of 10” for bust line

Step 7 : Select other markings and clock on point, now give value in Y box of 3” and click from top point Repeat 	
	 the same in X direction with 3”
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Step 8 : Give 1.5” in Y box and click at shoulder point for shoulder slope

Step 9 : Now join all points with lines and curves
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Step 10 : Now extract the pattern by selecting and select largest from right bottom corner, give name as Front, 	
	 now keep cursor on the pattern and see all the pattern lines need to be selected

Step 11 : Lift click and your pattern will be extracted
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Step 12 : Delete all the tracing lines with select tool and delete selection tool

Step 13 : Select Open a pattern and select all sizes from right bottom to open the pattern , now give a left click 	
	 on the center line to open the pattern
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Step 14 : To cut princess panel from shoulder first we need to draw a tracing curve on the pattern where we 		
	 need to cut the panel

	 For this select Draw curve and select 3 point bezier

Step 15 : Draw a curve defining the princess line from shoulder to bottom, the tracing line should be touching or 	
	 it should be on crossing over the pattern line
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Step 16 : Now select cut a pattern tool and all sizes and give piece name as panel 1, now keep cursor on the 		
	 left panel and give left click , you can see a new pattern had been extracted .

Step 17 : Press undo to get the same tracing lines back

	 Repeat it for right side panel naming panel 2 and center body as front
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Step 18 : Now you can see all 3 panels are separated and you can cut and stitch them together to form 		
	 princess line from shoulder to bottom.			    	
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Objectives

EXERCISE 11 : Grade Patterns 

At the end of this exercise you shall be able to
•	 grade patterns.

Tools/Materials
•	 Computer with pattern making, Grading software (Latest version)			 
•	 Measurement Chart	  	

Requirements

Procedure
Step 1
Measurement of basic sleeve grading spc

Step 2
Double click on ladies bodice icon to open on the
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Step 3
Click on any reach pds file in the folder

Step 4
Open the file in reach pds

Step 5
Click on the sleeve pattern in the piece bar at the bottom
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Step 6
Click on the setup menu and then size sub-menu

Step 7
In the right corner, add sizes from xs to xxl and click on apply to create sizes

Step 8
Click on tabular tools right side armhole point next apply to ddx 0.5 Apply
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Step 9
Same method left side sleeve armhole point

Step 10
Click on sleeve open point DDX apply measurement

Step 11
Click point left side sleeve open apply on measurement DDX
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Step 12
Next sleeve length measurement DDY 1 apply

Step 13
Next click on copy tool change auto and apply

Step 14
Apply on same point DDY 1 apply all size.
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Objectives

EXERCISE 12 : Draft Skirt Block

At the end of this exercise you shall be able to:
•	 drafting of skirt block.

Tools/Materials
•	 Computer with pattern making software (latest version)	 - 1 No.	
•	 Measurement chart	 - 1 No.

Requirements

Procedure
Step 1: Measurement of basic ladies skirt

Step 2: Create new folder named skirt on the desktop
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Step 3: Double click on reach pds icon to open

Step 4: Reach pds opens

Step 5: Click on piece menu from the menu bar
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Step 6: Click on new sub-menu in the piece menu

Step 7: Click on style in the right corner

Step 8: In the create style dialog prompt, click yes

CITS : Apparel - Sewing Technology  - Exercise 12 CITS : Apparel - Sewing Technology  - Exercise 12

© NIMI 

NOT TO BE REPUBLISHED



246

SEWING TECHNOLOGY - CITS

Step 9: Select skirt folder on the desktop

Step10: Click on the setup menu and then size sub-menu

Step 11: Enter the skirt size from the measurements given in the right corner to create sizes

CITS : Apparel - Sewing Technology  - Exercise 12

© NIMI 

NOT TO BE REPUBLISHED



247

SEWING TECHNOLOGY - CITS

Step 12: Click on setup menu and then unit sub-menu and click on cms

Step 13: Click on setup menu and then click on style sub-menu

Step 14: Select the base size as m from the dropdown in the bottom right corner
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Step 15: Click on draw menu and then click on lines sub-menu

Step 16: Click on the rectangle sub-sub-menu in the right corner or from the dropdown
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Step 18: Click on the screen and then click again to draw the rectangle

Step 17: Enter the measurements of hip level and length as the breath and length respectively and click on apply
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Step 19: Click on the zoom in icon          from the tool bar to zoom on top  corner point

Step 20: Click on move icon           from the toolbar to move the tracing
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Step 22: Click on the draw menu, curve sub-menu and 4 point bezier sub-sub-menu

Step 21: Select tracing pt from the dropdown in the bottom right corner, select length as 2 cm and click on apply. 
click on the point
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Step 23: Draw waist by joining the two points of the horizontal line

Step 24: Draw waist by joining the two points of the horizontal line

Step 25: Click on cut/delete icon            from the toolbar to delete the selection
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Step 26: Click on the draw menu, extract pattern and then largest

Step 27: Enter the name of the pattern as “front ct-1” in the bottom right corner and click on apply

Step 28: Move the mouse to the tracing till it turn dotted yellow. click on it to create the pattern
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Step 29: Click on the draw menu, lines sub-menu and click on the on vertical sub-sub-menu

Step 30: Enter the length as 20 cm marking hip line and click on apply. click on the top point and click again to 
create a vertical line

Step 31: Click on the draw menu, lines sub-menu and click on the horizontal sub-sub-menu

CITS : Apparel - Sewing Technology  - Exercise 12

© NIMI 

NOT TO BE REPUBLISHED



255

SEWING TECHNOLOGY - CITS

Step 32: Enter the length as 22 cm and click on apply. click on the top point and click again to create a 
horizontal line

Step 33: Click on the draw menu, insert point sub-menu and click on the in-pattern sub-sub-menu
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Step 34: Select the at point radio button and insert point at 20 cm marking in hip

Step 35: Click on move icon from the toolbar to move the point
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Step 37: Click on the draw menu, curve sub-menu and 4 point bezier sub-sub-menu

Step 36: Select pattern pt from the dropdown in the bottom right corner, select length as 7 cm, select horizontal 
radio button and click on apply. click on the point and it will be moved

CITS : Apparel - Sewing Technology  - Exercise 12 CITS : Apparel - Sewing Technology  - Exercise 12

© NIMI 

NOT TO BE REPUBLISHED



258

SEWING TECHNOLOGY - CITS

Step 38: Draw the waist shape by joining the points

Step 39: Click on the draw menu, extract pattern and then largest
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Step 41: Click On The Tool Menu, Then Create Darts Sub-Menu

Step 40: Move the mouse to the tracing till it turn dotted yellow. click on it to create to replace the pattern
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Step 42: Insert the measurements, select clockwise direction and click on apply

Step 43: Click on move icon  from the toolbar to move the front point by length 2 cm
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Step 45: select the pattern sub-menu from the right corner and click on the front ct-1 pattern

Step 44: Click on duplicate icon  from the toolbar and select the pattern sub-sub-menu from the bottom right 
corner to duplicate the pattern
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Step 46: Click ctrl+s to save the pattern named as back ct-1

Step 47: Click on move icon  from the toolbar to move the pattern. select pattern pt from the dropdown in the 
bottom right corner, enter length as -2 cm, select horizontal radio button and click on apply. click on the darts 
points
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Step 49: Click on move icon from the toolbar to move the internal. select internal from the dropdown in the bottom 
right corner, enter length as 5 cm, select vertical radio button and click on apply

Step 48: Click on the flip icon from the toolbar, click on pattern sub-sub-menu from the bottom right corner and 
click on apply. click on the back ct-1 pattern to flip it vertically
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Step 50: Click ctrl+s to save all the patterns
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Insert Design
Objectives : At the end of this exercise you shall be able to:
•	 insert knife pleat
•	 insert box pleat
•	 making panels
•	 adding yokes.

Tools/Materials
•	 Computer with pattern making software/Latest version	 - 1 No. 		
•	 Measurement chart  						     - 1 No.

Requirements

Procedure
	 TASK 1: Adding knife pleat

Step 1 : Select Tools options from the menu bar
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Step 2 : Click on add pleats

Step 3 : Select Knife pleat

Step 4 : After selecting knife pleat
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Step 5 : Give pleat depth value in the box

Step 6 : Press apply

Step 7 : Now select point to point on pattern segment where you need to insert pleat
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Step 8 : Pleat allowance will be added to the pattern

TASK 2 : Adding box pleat
Step 1 : Now select box pleat

Step 2 : Give pleat depth value
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Step 3 : Press apply

Step 4 : Select 2 pattern segments where you need to add the box pleat

Step 5 : You can observe an extra allowance that has been added to create box pleat

CITS : Apparel - Sewing Technology  - Exercise 12 CITS : Apparel - Sewing Technology  - Exercise 12

© NIMI 

NOT TO BE REPUBLISHED



270

SEWING TECHNOLOGY - CITS

TASK 3: Making panels
Step 1 :	 In Reach cad, we can cut a panel by using CUT A PATTERN TOOL

		  First, go to draw in menu bar

Step 2 : Select Draw line
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Step 3 : Click on Vertical line

Step 4 : Without selecting length, Draw a vertical line on the pattern where you need to cut a panel

Step 5 : The line should be intersecting 2 pattern segments
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Step 6 : For this trouser, the line should be from waist band to bottom hem

Step 7 : Now go to Tool option in menu bar

Step 8 : Select split
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Step 9 : Click in all sizes

Step 10 : At bottom right corner give New pieces name For example, give Front panel

Step 11 : Click apply

CITS : Apparel - Sewing Technology  - Exercise 12 CITS : Apparel - Sewing Technology  - Exercise 12

© NIMI 

NOT TO BE REPUBLISHED



274

SEWING TECHNOLOGY - CITS

Step 12 : Now keep cursor on the tracing line, and observe only the panel part should be selected

Step 13 : Now give a left click and your panel had been created as a new pattern

Step 14 : And the old pattern will remain as it is

If you want the other half without the panel. Repeat the process.
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TASK 4: Adding  yoke
Step 1 : First, go to Draw in menu bar

Step 2 : Select Draw line

Step 3 : Click on the horizontal line
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Step 4 : Without selecting length, draw a horizontal line on the pattern where you need to cut a yoke

Step 5 : The line should be intersecting 2 pattern lines

Step 6 : Select Cut a pattern on tool bar
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Step 7 : At the bottom right corner select All sizes

Step 8 : Give the new pieces name. For example, give yoke

Step 9 : Click apply
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Step 10 : Now keep the cursor on the tracing line, and observe only the yoke part should be selected

Step 11 : Now give a left click, and your new yoke had been created as a new pattern

Step 12 :	 And the old pattern will remain as it is

		  If you want the other half back without yoke

Press redo, and the same tracing line will appear in the same place
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Objectives

EXERCISE 13 : Sleeves  Block 

At the end of this exercise you shall be able to
•	 develop sleeve blocks
•	 develop bell sleeves
•	 develop butterfly sleeves
•	 develop tulip sleeves (petal sleeves)

Tools/Materials
•	 Computer with pattern making software (Latest version ) 		  -1No.		
•	 Measurement chart	

Requirements

Procedure
TASK 1 : Sleeve blocks
Step 1 : Measurements for half sleeve pattern

M

Sleeve length 8

SLV opening 10

BICEPS 11

Step 2 : Select Draw line from tool bar

Step 3 : Select vertical line from bottom right corner
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Step 4 : Select the length and give sleeve length value 8” as per our measurement chart

Step 5 :	 Now give one left click on screen and drag the mouse in vertical direction and give one more left click 	
	 so that you can get 8” of line

Step 6 : Now select horizontal line from bottom corner and select length and give value of 5.5”
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Step 7 : Now draw a horizontal line of 5.5” starting from top point of vertical line

Step 8 :	 Draw one more horizontal line from bottom of vertical line for sleeve opening, the measurement of 		
	 sleeve opening is 10”, so we are going to draw half of the pattern so divide bottom measurement into 2 	
	 parts.

	 Give 5” value in the box and press apply

Step 9 : Draw a horizontal line starting from bottom of vertical line

Step 10 : Now select other markings from tool bar
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Step 11 : Give 3” value in vertical column on bottom left of the screen

Now we need to mark sleeve cap height for that give a left click on the corner point

Step 12 : Select normal line and connect sleeve cap height point to sleeve opening point

Step 13 : Now draw a line connecting sleeve center point and sleeve cap point

Step 14 : Select draw curves tool on tool bar
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Step 15 : Select 3 point Bezier and draw back sleeve curve

Step 16 :	 Now draw a 3 point curve connecting sleeve center point and sleeve cap point. This curve is back 		
	 curve of sleeve

Step 17 : Now repeat with 4 point Bezier for front curve

Step 18 : Select Open a pattern option on tool bar
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Step 19 : Select Tracing on bottom right corner

Step 20 : Click on the sleeve center line to open it

Step 21 : The sleeve will be open

Step 22 : Now by selecting Select tool delete all unwanted lines in tracing
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Step 23 : Extract the pattern my giving new pattern name

Step 24 : Keep cursor on any pattern line and observe all the pattern lines should be selected and give left click,
You can see a new pattern of sleeve had been extracted

TASK 2: Bell sleeve
Measurements for Bell Sleeve Pattern

M

Sleeve length 25

SLV opening 10

Armhole round 20
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Step 1 : Select Draw line from tool bar

Step 2 : Select vertical line from bottom right corner

Step 3 : Select the length and give sleeve length value 25” as per our measurement chart

CITS : Apparel - Sewing Technology  - Exercise 13

© NIMI 

NOT TO BE REPUBLISHED



287

SEWING TECHNOLOGY - CITS

Step 4 : Now give one left click on screen and drag the mouse in vertical direction and give one more left click so 
that u can get 25” of line

Step 5 : Now we need to draw sleeve opening, according to our measurement chart sleeve opening is 10”, so we 
are going to draw half of the sleeve so divide 10 by 2 that is 5”.

Select horizontal line from bottom corner and select length and give value of 5”.

Step 6 : Now draw a horizontal line of 5” starting from bottom point of vertical line.

This line is our sleeve opening line.
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Step 7 : Draw one more horizontal line from top of vertical line, the measurement of armhole round is 20”, so we 
are going to draw half of the pattern so divide Armhole measurement into 2 parts.

Give 10” value in the box and press apply.

Step 8 : Draw a horizontal line starting from top of vertical line.

Step 9 : Now select other markings from tool bar.
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Step 10 : Give 3” value in vertical column on bottom left of the screen.

Step 11 : Now we need to mark sleeve cap height for that give a left click on the corner point.

Step 12 : Select normal line and connect sleeve cap height point to sleeve opening point.
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Step 13 : Now draw a line connecting sleeve center point and sleeve cap point.

Select.

Step 14 : Select draw curves tool on tool bar.

Step 15 : Select 4 point Bezier and draw back sleeve curve.
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Step 16 : Now draw a 4 point curve connecting sleeve center point and sleeve cap point.

Step 17 : Select Open a pattern option on tool bar.

Step 18 : Select Tracing on bottom right corner.
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Step 19 : Left click on the sleeve center line to open it.

Step 20 : The sleeve will be open.

Now by selecting Select tool delete all unwanted lines in tracing.

Step 21 : Extract the pattern my giving new pattern name.
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Step 22 : Give the pattern name and press apply.

Step 23 : Keep cursor on any pattern line and observe all the pattern lines should be selected and give left click.

Step 24 : You can see anew pattern of sleeve had been extracted.
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Step 25 : Select Insert point in curve from tool bar.

Step 26 : Select In Pattern from bottom right corner.

Step 27 : Select Parts and give 2 value in the box and press apply.
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Step 28 : Now give a left click on both bottom corners.

Step 29 : New points will be inserted by dividing 2 vertical lines.

Step 30 : Now select grading tool and click on all corner points to make tem grade points.

CITS : Apparel - Sewing Technology  - Exercise 13 CITS : Apparel - Sewing Technology  - Exercise 13

© NIMI 

NOT TO BE REPUBLISHED



296

SEWING TECHNOLOGY - CITS

Step 31 : Now with the help of move tool we will create extra allowance for bell sleeve.

Step 32 : Give 5” value in in length and select Pattern point and select horizontal.
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Step 33 : By giving one left click on the bottom corner point of sleeve drag the point right and left sides.

Step 34 : Convert sleeve opening to slight curve to get perfect fall For that first draw a curve with 3 point bezier.

Step 35 : Select replace from extract pattern tool.
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Step 36 : Press apply and select point to point from clock wise direction.
The tracing curve will be converted into pattern curve.

TASK 3 : Butterfly sleeve
Step 1 : Select Draw line from tool bar.

Step 2 : Select vertical line from bottom right corner.
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Step 3 : Select the length and give sleeve length value 8” as per our measurement chart.

Step 4 : Now give one left click on screen and drag the mouse in vertical direction and give one more left.

click so that u can get 8” of line.

Step 5 : Now we need to draw sleeve opening, according to our measurement chart sleeve opening is 11”, so we 
are going to dray half of the sleeve so divide 11 by 2 that is 5.5”.

select horizontal line from bottom corner and select length and give value of 5.5”.
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Step 6 : Now draw a horizontal line of 5.5” starting from bottom point of vertical line.

This line is our sleeve opening line.

Step 7 : Draw one more horizontal line from top of vertical line, the measurement of armhole round is 20”, so we 
are going to draw half of the pattern so divide Armhole measurement into 2 parts.

Give 10” value in the box and press apply.

Step 8 : Draw a horizontal line starting from top of vertical line.
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Step 9 : Now select other markings from tool bar.

Step 10 : Give 3” value in vertical column on bottom left of the screen.

Step 11 : Now we need to mark sleeve cap height for that give a left click on the corner point.
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Step 12 : Select normal line and connect sleeve cap height point to sleeve opening point.

Step 13 : Now draw a line connecting sleeve center point and sleeve cap point. 

Select.

Step 14 : Select draw curves tool on tool bar.
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Step 15 : Select 4 point Bezier and draw back sleeve curve.

Step 16 : Now draw a 4 point curve connecting sleeve center point and sleeve cap point.

Step 17 : Select Open a pattern option on tool bar.
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Step 18 : Select Tracing on bottom right corner.

Step 19 : Left click on the sleeve center line to open it.

Step 20 : The sleeve will be open.
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Step 21 : Now by selecting Select tool delete all unwanted lines in tracing.

Step 22 : Extract the pattern my giving new pattern name.

Step 23 : Give the pattern name and press apply.
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Step 24 : Keep cursor on any pattern line and observe all the pattern lines should be selected and give left click.
You can see a new pattern of sleeve had been extracted.

Step 25 : Now select Insert point in curve tool.

Select pattern. 

Step 26 : Select At distance and give 3.5 inch value and press apply.
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Step 27 : Give left click on the center point of sleeve cap.

Step 28 : Repeat the same by giving -3.5inches value to get a point on left side of center point. 

Step 29 : Repeat the same on sleeve opening.
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Step 30 : Now to add fullness select create fullness to a pattern tool.

Step 31 : Give 2” depth and Number of cuts 1.

Step 32 : Give a left click on bottom line point and 2nd left click on sleeve cap point.

Repeat it for all 3 point.
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Step 33 : Fullness will be added at the bottom of the sleeve and pattern will be rotated slightly.

Step 34 : Select align pattern direction and select horizontal and press apply.

Step 35 : Select both bottom corner points by left click.
And the pattern will be placed straight on the screen.
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Step 36 : To get more frills look select move tool and select pattern point and give value of 3” and by giving left 
Click on the corner point drag to create extra fullness.

TASK 4: Tulip Sleeve (Petal Sleeve)
Step 1 : Select Draw line from tool bar.

Step 2 : Select vertical line from bottom right corner.
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Step 3 : Select the length and give sleeve length value 8” as per our measurement chart.

Step 4 : Now give one left click on screen and drag the mouse in vertical direction and give one more left click so 
that u can get 8” of line.

Step 5 : Now we need to draw sleeve opening, according to our measurement chart sleeve opening is 11”, so we 
are going to draw half of the sleeve so divide 11 by 2 that is 5.5”. Select horizontal line from bottom corner and 
select length and give value of 5.5”.
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Step 6 : Now draw a horizontal line of 5.5” starting from bottom point of vertical line. This line is our sleeve 
opening line.

Step 7 : Draw one more horizontal line from top of vertical line, the measurement of armhole round is 20”, so we 
are going to draw half of the pattern so divide Armhole measurement into 2 parts.

Give 10” value in the box and press apply.

Step 8 : Draw a horizontal line starting from top of vertical line.

CITS : Apparel - Sewing Technology  - Exercise 13

© NIMI 

NOT TO BE REPUBLISHED



313

SEWING TECHNOLOGY - CITS

Step 9 : Now select other markings from tool bar.

Step 10 : Give 3” value in vertical column on bottom left of the screen.

Step 11 : Now we need to mark sleeve cap height for that give a left click on the corner point.
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Step 12 : Select normal line and connect sleeve cap height point to sleeve opening point.

Step 13 : Now draw a line connecting sleeve center point and sleeve cap point.

Step 14 : Select draw curves tool on tool bar.
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Step 15 : Select 4 point Bezier and draw back sleeve curve.

Step 16 : Now draw a 4 point curve connecting sleeve center point and sleeve cap point.

Step 17 : Select Open a pattern option on tool bar.
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Step 18 : Select Tracing on bottom right corner.

Step 19 : Left click on the sleeve center line to open it.

Step 20 : The sleeve will be open.

CITS : Apparel - Sewing Technology  - Exercise 13

© NIMI 

NOT TO BE REPUBLISHED



317

SEWING TECHNOLOGY - CITS

Step 22 : Extract the pattern my giving new pattern name.

Step 23 : Give the pattern name and press apply.

Step 21 : Now by selecting Select tool delete all unwanted lines in tracing.
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Step 24 : Keep cursor on any pattern line and observe all the pattern lines should be selected and give left click,
You can see anew pattern of sleeve had been extracted.

Step 25 : Now select Insert point in curve tool Select pattern.

Step 26 : Select At distance and give 3.5 inch value and press apply.
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Step 28 : Repeat the same by giving -3.5inches value to get a point on left side of center point.

Step 29 : To cut a pattern first we need to draw a tracing curve by selecting Draw curve tool from tool bar and 
select 3 point bezier.

Step 27 : Give left click on the center point of sleeve cap.
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Step 30 : Select Cut a pattern tool and select All sizes.

Step 31 : Give piece name as SLEEVE 1 and keep cursor on one of the tracing line, you can observe particular 
sleeve panel will be selected.

Step 32 : Give a left click to extract that panel separately.
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Step 34 : Select Move tool to move them separately.

Step 33 : Repeat same by giving sleeve 2 name and extract next panel.
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Develop Collars
Objectives : At the end of this exercise you shall be able to:
•	 develop of shirt collar
•	 develop of peter pan collar 
•	 develop of stand collar
•	 develop of flat collar

Tools/Materials
•	 Computer with pattern making software (latest version)	 -1 No.
•	 Measurement chart 						     -1 No.

Requirements

Procedure
TASK 1: Shirt collar
Step 1 : Select Draw line from the tool bar.

Step 2 : Select Rectangle from the bottom right corner.
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Step 3 : Select breadth and height and give values in the box as 8” and 3” respectively.

Step 4 : Now draw a rectangle on the screen by giving one left click, drag the cursor and one more left click.

A rectangle will appear on the screen.

Step 5 : Now divide the rectangle in 2 parts.

A rectangle will appear on the screen.
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Step 6 :Now divide the rectangle in 2 parts.

Select Insert point from the tool bar.

Step 7 : Select In Tracing from the bottom right corner.

Step 8 : Select At Distance and give value in the box as 1”.
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Step 9 : Left click on the bottom left corner of the rectangle.

Step 10 : Repeat the same in the bottom right corner by giving -1” in the At Distance value box.

Step 11 : Now join both points with normal line from the tool bar.
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Step 12 : Select normal line from the tool bar, select length and give value in the box as 3’’.

Step 14 : Select Draw curve from the tool bar and select 3-point Bezier from the bottom right corner.

Step 13 : Draw the line to create collar spread point.
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Step 15 : Now draw a curve connecting collar center to collar point.

Step 16 : Select Other Markings from the tool bar and select Point from the bottom right corner.

Step 17 : Give Horizontal value as 1” and vertical value of -0.25” at same time on the bottom left corner.
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Step 18 : Left click near the bottom right point of the rectangle.

Step 19 :  A point will appear.

Join the point with a 4-point Bezier.

Step 20 : Select Extract Pattern from the tool bar.
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Step 21 : Select Largest from the bottom right corner

Step 23 : Keep the cursor on the collar line and observe that only the collar line segments are selected.

Left click to extract the collar.

Step 22 : Give name to the new piece as collar and click on apply.
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Step 24 : Repeat the same to extract collar band. Give name in the extract pattern box and select bottom lines 
to extract the neck band.

Step 25 : Now delete the tracing by using the select tool from the tool bar and then select delete from the tool bar.

Step 26 : Select Open tool from the tool bar to open a pattern tool.
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Step 27 : Select All Sizes from the bottom right corner.

Step 28 : Left click on the center lines of both collar and collar band.

Step 29 : Both the patterns will open after left click.
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TASK 2 : Peter Pan Collar

Step 1 : By aligning front and back patterns we can drape a patter pan collar

Step 2 : Select Align pattern direction from tool bar
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Step 3 : Select horizontal and click on the shoulder point to point on shoulder, repeat it for front and back

Step 4 : Select flip a pattern and select pattern and select horizontal
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Step 5 : Now by giving left click, move cursor to left and second left click

Your back pattern had been flipped horizontally

Step 6 : Select move tool and place the front and back shoulders touching each other and place the piece

Step 7 : Now draw peter pan collar by using lines and curves
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Step 8 : Select extract pattern and select smallest

Step 9 : Give name as collar and press apply

Step 10 : Keep cursor on the tracing lines and observe the collar lines should be selected and press lift click to 
extract a pattern
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Step 11 : A new collar pattern had been extracted

Step 12 : If you want a one piece continue collar you can open it by selecting open a pattern and select all sizes
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Step 13 : Click on the center line to open it
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TASK 3 : Stand Collar

Step 1 : Select DRAW LINE from tool bar and select rectangle from right bottom corner

Step 2 : Give value of width 8 inch and height 1 inch and press apply
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Step 3 : Give a left click move the cursor and one more left click 

You can see 8X1 inch rectangle will be appear on the screen

Step 4 : Now select other markings and select point

Step 5 : At left bottom corner give Y or vertical value of -1” 

And press apply
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Step 6 : Give a left click from left top corner point to get a point 1” point on top of it

Step 7 : Now give 0.5” at X or horizontal box and press apply

Step 8 : Give a left click on the new point

You can observe a new point appears on the right side of new point
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Step 9 : Select draw curve from tool bar and select 3point Bezier

Step 10 : Connect the point with smooth curves

Step 11 : Select Draw lines and clock on normal line 

And joint 2 points with line
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Step 12 : Select Extract pattern and click on smallest and give name as stand collar and press apply

Step 13 : Now keep cursor on the collar line and observe all the lines related to collar should be selected and 
give a left click

Step 14 : A new pattern will be extracted in pattern area
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Step 15 : Select open a pattern and select All sizes

Step 16 : Click on center back line of collar and open the collar

Step 17 : Delete all the tracing lines by select tool and delete selection tool
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TASK 4 : Flat Collar

Step 1 : Select DRAW LINE from tool bar and select rectangle from right bottom corner

CITS : Apparel - Sewing Technology  - Exercise 13

© NIMI 

NOT TO BE REPUBLISHED



345

SEWING TECHNOLOGY - CITS

Step 2 : Give value of width 8 inch and height 1 inch and press apply

Step 3 : Give a left click move the cursor and one more left click 

You can see 8X1 inch rectangle will be appear on the screen

Step 4 : Now select other markings and select point
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Step 5 : At left bottom corner give Y or vertical value of -2” 

And press apply

Step 6 : Give a left click from left top corner point to get a point 2” point on top of it

Step 7 : Now give 0.5” at X or horizontal box and press apply
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Step 8 : Give a left click on the new point

You can observe a new point appears on the right side of new point

Step 9 : Select draw curve from tool bar and select 4point Bezier
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Step 10 : Connect both points with parallel curve]

Step 11 : Now select extract a pattern and give name Flat collar and extract the collar

Step 12 : Now keep cursor on the collar line and observe all the lines related to collar should be selected and 
give a left click
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Step 13 : Now give left click your new flat collar pattern had been extracted

Step 14 : Clear all the tracing with select and delete selection option

Step 15 : Select open a pattern and select All sizes
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Step 16 : Click on center back line of collar and open the collar
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Objectives

EXERCISE 14 : Develop Pattern With Spec Sheet 

At the end of this exercise you shall be able to
•	 sketching and conceptualization
•	 pattern development.

Tools/Materials
•	 Requirement Identification	
•	 Structured Organization 

Requirements

Procedure
	 Develop Pattern With Spec Sheet 
	 Sure, here’s a basic example of how you can create a design using  marker/general tools and 3D software to 

develop patterns along with  a spec sheet: 

1	 Sketching and Conceptualization: 
-	 Begin by sketching out your design concept on paper or digitally 

using drawing software. 

- 	 Determine the overall style, silhouette, and details of your design. 

2	 Marker/General Tools: 
-	 Use markers, colored pencils, digital painting tools to add color and 

texture to your design sketch. 

- 	 Experiment with different color combinations and material finishes 
to bring your design to life.

3	 3D Modeling: 
- 	 Transfer your design concept into  a 3D modeling software such as 

Blender,  Autodesk Maya, or Rhino. 

- 	 Create a 3D model of your design, paying attention to proportions, 
shapes, and details. 
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4	 Pattern Development: 
-	 Use the pattern-making tools within the 3D software to develop patterns for your design. 

-	 Adjust the patterns to fit the 3D model accurately, ensuring proper  alignment and symmetry. 

5	 Texture and Material Application: 
- 	 Apply textures and materials to the  3D model to simulate different fabrics and finishes. 

- 	 Experiment with different shaders  and material properties to achieve  the desired look for each component  
of your design.

6	 Rendering: 
- 	 Render high-quality images of your 3D model from various angles 

to showcase the design details and features. 

- 	 Use lighting and camera settings to enhance the visual appeal of 
your renders. 

7	 Spec Sheet: 
-	 Create a spec sheet detailing important information about your  design, such as measurements, materials, 

colors, and construction  techniques. 

-	 Include technical drawings or illustrations to illustrate key features and construction details. 

-	 Provide any additional notes or instructions for production.

8	 Final Presentation: 
- 	 Compile your design sketches, 3D renders, and spec sheet into 

a cohesive presentation. 

- 	 Use digital presentation software or create a physical portfolio to 
showcase your design to clients or stakeholders. 

	 By following these steps, you can effectively use marker/general tools  and 3D software to develop patterns and 
create detailed designs along  with a spec sheet for production. 
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Objectives

EXERCISE 15-21 : Practice Of Marker Tools 

At the end of this exercise you shall be able to
•	 sketch the outline
•	 define shapes.

Tools/Materials
•	 Pencil, French Curve	
•	 Measuring Tape

Requirements

Procedure
	 Practice Of Marker Tools 
	 Sure, I can guide you through creating a simple design  using basic marker tools. Here’s a step-by step process:   

1	 Sketch the Outline:  
-	 Start by lightly sketching the outline of your design using a pencil. This will serve as a guide for your marker 

work.(Fig 1)

2	 Define Shapes: 
-	 With a thicker marker, start defining the main shapes of your design. You can use different strokes (straight 

lines, curves, etc.) to add interest. (Fig 2)

3	 Add Details: 
- 	 Use thinner markers or fine liners  to add details to your design.  This could include textures, patterns, or 

intricate elements depending on your design. (Fig 3)

4	 Shading and Highlights:
-	 Use markers of varying shades to  add shading and depth to your design. You can also use a white gel pen 

to add highlights or enhance certain areas. (Fig 4)

Fig 1 Fig 2
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5	 Final Touches: 
- 	 After coloring, you can go back and add any final touches  or corrections to your design. This could include 

refining  lines, adjusting colors, or adding additional details. (Fig 5)

	 Note: All the figure show in pages, Are Different from each other, this picture Are given for reference 
purposes only.

Remember to take your time and have fun with the  process! Experiment with different techniques and see  
what works best for your design. 

Fig 3

Fig 5

Fig 4
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Make Marker of T shirt in tubular fabric
Objectives : At the end of this exercise, you shall be able to:
•	 open the marker making software
•	 create a new marker file and make initial set up
•	 make economical layout
•	 save and create marker consumption.

Tools/Equipments/Instruments
•	 Computer with software for Pattern 			 

Making (Latest Version)	 - 1 No.

Requirements

TASK 1: Open the marker making software
1	 Double click the icon MARKER MAKING on the desk- top*

	 OR

Choose all programme > MARKER MAKING> from the start menu.

TASK 2 : Create a new marker file and make initial setup
1 Click icon New             in the tool bar. 

2	 Select the marker from the setup menu bar.

Procedure
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3	 Enter data in new marker dialog box. 

4	 Click OK.

5	 Select pieces from the setup menu bar. 
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6	 Enter the piece name and number of pieces in the dialog box.

7	 Click OK.

8	 Select ratio from the setup menu bar.

9	 Enter size,ratio and colour in the ratio dialog box 10 Click OK.

11	Select fabric from setup menu box.

12	Enter value in the frame dialog box.

13	Click ok.
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TASK 3 : Make economical layout 
1	 Select Open style files from the file menu.

2	 Select the graded pattern file of * ‘T shirt’ already pre- pared (Ref.Ex.No.1.30)

3	 Click OK.

4	 Click move tool icon.

5	 Click required pieces on piece bar and drag to placing it in the working area for making layout. 

6 	 Follow the above procedure and arrange all patterns economically on the working area of the marker to 
achieve the maximum efficiency.

TASK 4 : Save and Create marker consumption
1	 Click save icon from tool bar after completing the marker planning.

2	 Select consumption from calculation of menu bar to view the marker consumption detail.

Create a Marker for trousers
Objectives : At the end of this exercise, you shall be able to:
•	 create a marker for trousers by manual selection
•	 create a marker for trousers by auto nesting.

Tools/Equipments/Instruments
•	 Computer with software for Pattern 			 

Making (Latest Version)	 - 1 No.

Requirements

Procedure
TASK 1: Create a marker for trousers by manual selection.
1	 Open the marker making software.

2	 Create a new marker file and make initial set up.

3	 Select open style files from the file menu.
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TASK 2: Create a marker for trousers by auto nesting
1	 Open the marker making software.

2	 Create a new marker file and make initial set up.

3	 Select open style files from the file menu.

4	 Select the graded pattern file of ’Gent’s Trousers’ already prepared (Ref.Ex.No.1.32).

5	 Click OK.

6	 Click on auto nesting to place the pattern pieces automatically to create the marker.

7	 Save the file.

8	 Select consumption from calculation of menu bar to view the marker consumption detail.

4	 Select the graded pattern file of ‘Gent’s Trousers.

5	 Click OK.

6	 Click move tool icon.

7	 Select required pieces on piece bar and drag to placing it in the working area for making layout.

8	 Follow the above procedure and arrange all patterns economically on the working area of the marker to 
achieve the maximum efficiency.(Fig 1)

9	 Click save icon from tool bar after completing the marker planning.

10	Select consumption from calculation of menu bar to view the marker consumption detail
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Plan and practice of making
Objectives : At the end of this exercise you shall be able to
•	 short
•	 flip & rotate, import.

Tools/Materials
•	 PC/Laptop with windows	
•	 MS Excel with software

Requirements

Procedure
	 Plan and practice of making marker  
	 Sure, here’s a plan and practice guide for making a marker using  marker-making software:    

1	 Shoot:  
-	 Begin by capturing images or scans of your patterns or pieces  to be 

used in the marker. 

2	 Flip & Rotate: 
-	 Use the marker-making software to adjust the orientation of  the patterns as needed, flipping or rotating 

them to optimize fabric usage. 

3	 Auto Nesting: 
- 	 Utilize the auto-nesting feature of the software  to automatically arrange the pattern pieces on the marker,  

minimizing fabric waste and maximizing efficiency. 

4	 Batch: 
-	 If you have multiple markers to create or multiple sets  of patterns to work with, use the batch processing 

feature to  streamline the process and save time.

5	 Merge: 
- 	 In case you have individual pattern pieces that need  to be combined or merged into larger pieces, use the 

merge  function within the software to create cohesive pattern layouts. 

6	 Import: 
- 	 Import any additional pattern pieces,  fabric specifications, or other relevant data into the marker-making 

software to ensure all necessary information is included in the marker. 
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7	 Export:  
-	 Once the marker is complete, export it in the desired  file 

format (such as DXF or PDF) to be used for cutting or 
production purposes.

Practice: 
-	 Start by familiarizing yourself with the software interface and  tools. 

- 	 Practice shooting and importing patterns into the software. 

- 	 Experiment with flipping, rotating, and merging pattern pieces  to understand how to optimize layouts. 

- 	 Use the auto-nesting feature to create markers efficiently. 

- 	 Create multiple markers in batch mode to get comfortable  with the process. 

-	 Export markers and review them to ensure accuracy and  effectiveness. 

	 Consistent practice will help you become proficient in making markers using marker-making software, allowing 
you to  optimize fabric usage and streamline your production process.
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Objectives

EXERCISE 22-28 : Identify & Select 3D tools  

At the end of this exercise you shall be able to
•	 versatility, unique features
•	 open-source, Idynami brushes.

Tools/Materials
•	 PC/Laptop with windows		
•	 3D Printing, Modeling

Requirements

Procedure
	 Identify & Select 3D toolsfy & Select 3D tools Identify & Select 3D tools  

1	 Blender: 
 - 	 Versatility: Blender is a versatile 3D creation suite that  covers the entire pipeline, from modeling and 

animation to  rendering and compositing. 

 - 	 Open-Source: Being open-source, Blender is free to use,  making it accessible to a wide range of users, 
from professionals  to hobbyists. 

 - 	 Community Support: It boasts a large and active  community that contributes plugins, tutorials, and 
resources,  enhancing its functionality and usability. 

- 	 Regular Updates: Blender undergoes frequent updates  and improvements, ensuring that it stays 
competitive and up to-date with industry standards.

2	 Autodesk Maya: 
-	  Industry Standard: Maya is widely regarded as an  industry-standard tool for 3D modeling, animation, and  

rendering, particularly in film, TV, and game development. 

- 	 Comprehensive Toolset: It offers a comprehensive set of   tools for character animation, effects, and 
modeling, allowing  for complex and realistic creations. 
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- 	 Integration: Maya integrates seamlessly with other  Autodesk products like 3ds Max and MotionBuilder, 
facilitating  a smooth workflow for professionals. 

- 	 Scripting and Customization: Maya provides extensive  scripting capabilities, allowing users to automate 
tasks and  customize the software to suit their specific needs.

3	 ZBrush: 
 - 	 Digital Sculpting: ZBrush specializes in digital sculpting,  offering powerful tools for creating highly detailed 

and realistic  models. 

 - 	 Unique Features: Its 3D/2D modelling, texturing, and  painting capabilities are unique and well-suited for 
character  and creature design. 

 - 	 High-Resolution Detailing: ZBrush excels in handling  high-resolution models, making it a preferred 
choice for  creating intricate designs for games, movies, and digital art. 

- 	 lDynamic Brushes: It offers a wide range of dynamic  brushes and sculpting tools that simulate real-world 
sculpting  techniques, giving artists more control and flexibility.

These three tools represent a diverse range of capabilities  and are widely used across various industries for 3D  
modeling, animation, and rendering needs. Each has its  strengths and target audience, catering to professionals  
and enthusiasts alike.
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Explain Model Property
Objectives : At the end of this exercise you shall be able to
•	 accuracy, interpretability
•	 precision, computational efficiency.

Tools/Materials
•	 PC/Laptop with windows		
•	 Data Science

Requirements

Procedure
 	 Model properties in practical terms refer to characteristics  essential for effective model usage:

1	 Accuracy: : In practical terms, accuracy refers to how  closely the model’s predictions or simulations match  
real-world observations. Achieving high accuracy  involves minimizing errors between the model’s outputs  
and the ground truth data. For example, in predictive  modeling, accuracy is often measured using metrics  like 
Mean Squared Error (MSE) or Root Mean Squared  Error (RMSE), which quantify the average discrepancy  
between predicted and actual values.

2	 Precision: Precision encompasses the level of detail  and specificity in the model’s outputs. A precise model  
provides granular insights into the problem domain,  enabling stakeholders to make fine-grained decisions.  
For instance, in medical diagnostics, a precise model  can accurately identify subtle patterns or abnormalities  
in patient data, aiding in early disease detection and  treatment planning.

3	 Scalability: Scalability refers to the model’s ability to  handle increasing volumes of data or complexity  without 
sacrificing performance or efficiency.  Practically, this means that as the size of the dataset or  the complexity 
of the problem grows, the model should  be able to process and analyze the data within  reasonable time and 
resource constraints. Scalable  models are essential for applications such as large scale data analytics, where 
processing massive  datasets efficiently is paramount. 

4	 Interpretability: Interpretability concerns the ease with  which humans can understand and explain the 
model’s  outputs. In practical terms, an interpretable model  provides transparent insights into the underlying  
mechanisms driving its predictions or decisions. This is  crucial for gaining stakeholders’ trust and confidence 
in  the model’s reliability. For example, in financial risk  assessment, an interpretable model allows analysts to  
identify the key factors influencing risk scores,  facilitating informed risk management strategies.

5	 Generalizability: Generalizability refers to the model’s  ability to perform well on unseen data or in diverse  
scenarios beyond the training data. A model with high   generalizability can effectively capture underlying  
patterns and trends in the data, enabling reliable  predictions or simulations in real-world settings.  Practical 
applications require models that can  generalize well to new situations, ensuring robust  performance across 
different contexts. 

6	 Robustness: Robustness reflects the model’s  resilience to noise, uncertainty, or variations in input  data. A 
robust model maintains its performance even in  the presence of unexpected challenges or changes in  the 
environment. This property is particularly important  in dynamic or unpredictable domains where data  quality 
may vary over time. For example, in autonomous  driving systems, robust models can accurately perceive  
and react to complex and rapidly changing traffic  conditions.

7	 Computational Efficiency: Computational efficiency  relates to the model’s ability to produce results within  
reasonable time and resource constraints. Practical  models should be computationally tractable, meaning  
they can efficiently process and analyze data without  excessive computational burden. Efficiency is critical  
for real-time applications like algorithmic trading, where  timely decision-making is essential for capitalizing on  
market opportunities. 

CITS : Apparel - Sewing Technology  - Exercise 22-28

© NIMI 

NOT TO BE REPUBLISHED



365

SEWING TECHNOLOGY - CITS

8	 Domain Specificity: Some models are tailored for   specific domains or industries, incorporating domain 
specific knowledge and assumptions to improve their  relevance and effectiveness. Domain-specific models  
leverage insights and expertise unique to a particular  field, allowing them to capture intricacies and nuances  
that generic models may overlook. For instance, in  weather forecasting, domain-specific models  incorporate 
meteorological principles and regional  climate data to provide accurate and localized  predictions.

9	 Adaptability: Adaptability refers to the model’s ability  to learn and evolve over time, incorporating new data or  
insights to improve its performance. Adaptive models  can dynamically adjust their parameters or structures in  
response to changing conditions, ensuring continued  relevance and effectiveness in dynamic environments.

    Practical applications often require models that can  adapt to evolving trends, preferences, or user  behaviors, 
such as recommendation systems in e commerce platforms. 

10	Ethical Considerations: Ethical considerations  are increasingly important in model development and  
deployment, particularly as AI technologies impact  individuals and society. Practical models should  consider 
ethical implications such as fairness,  transparency, and privacy to ensure equitable and  responsible 
outcomes. Ethical considerations may  involve mitigating biases in training data, ensuring  transparency in  
decision-making processes, and  safeguarding sensitive information. By addressing  ethical concerns, models 
can uphold ethical standards  and promote trust and accountability among users and  stakeholders.

	 By considering these diverse properties, practitioners can  evaluate and select models that align with their specific  
needs, objectives, and constraints in various practical  applications, ultimately driving meaningful insights and  
informed decision-making.
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Open, save & customize with the help of 3D tools
Objectives : At the end of this exercise you shall be able to:
•	 versatility, unique features
•	 open-source, Idynami brushes.

Tools/Materials
•	  PC/Laptop with windows		
•	  3D Printing, Modeling	

Requirements

Procedure
Certainly! Here’s a more detailed step-by-step procedure for opening,  saving, and customizing a 3D model using 
Blender: 

Opening a 3D model
1	 Launch Blender: Open Blender by double-clicking its icon or selecting it from  your applications menu. 

2	 Access file menu : Once Blender is open, look for the top menu bar. Click on the  “File” menu. 

3	 Select Open : In the dropdown menu that appears under “File,” select “Open”  or use the keyboard shortcut 
Ctrl + O. 

4	 Browse for model : A file browser window will pop up. Navigate to the location on  your computer where the 
3D model file is stored. 

5	 Choose file : Click on the desired 3D model file to select it.

6	 Open model : After selecting the file, click on the “Open” button in the file  browser window to load the model 
into Blender. 

Saving a 3D model 
1	 Navigate to File Menu : If you’ve made changes to the model and want to save them,  go to the “File” menu 

again. 

2	 Select save or save as : Choose either “Save” if the model is already saved, or “Save  As” if it’s a new file or 
you want to save it with a different  name/location. 

3	 Specify name and location : A file browser window will appear. If using “Save As,” specify  the name and 
location where you want to save the file. If using  “Save,” Blender will overwrite the existing file. 

4	 Choose file forma : Select the appropriate file format for your needs. Blender’s  native format is blend, but 
you can also choose other formats  like .obj, .fbx, or .stl. 

5	 Click save : Once you’ve specified the name, location, and format, click  “Save” to save the model.

Customizing a 3D model 
1	 Select Object : If you want to customize the model’s geometry, select the  object you want to edit by right-

clicking on it in the 3D  viewport. 

2	 Enter edit mode : To modify the object’s vertices, edges, or faces, enter “Edit  Mode” by pressing Tab or 
selecting it from the mode dropdown  menu at the bottom of the 3D viewport. 

3	 Use editing tools : In Edit Mode, you can use various tools like “Extrude,” “Scale,” “Rotate,” etc., available in 
the toolbar on the left or through                 

4	 Texture and material editing : To customize textures and materials, you can switch to  “Texture Paint” mode 
or “Shading” workspace to adjust materials, textures, and lighting. 

 5	 Sculpting: For organic shapes or fine details, you can switch to “Sculpt  Mode” and use sculpting brushes to 
mold and shape the model.
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6	  Experiment and Iterate : Customizing a 3D model is an iterative process. Experiment  with different tools and 
techniques, undo changes if needed (Ctrl + Z), and save your progress regularly. 

7	 Finalize and save : Once you’re satisfied with the customization, go back to Object  Mode (Tab), navigate to 
the “File” menu, and save your  changes as described in the previous section. 

By following these detailed steps, you should be able to efficiently  open, save, and customize 3D models using 
Blender or similar 3D  modeling software

Place Cloth, Clear Cloth, Single Draping, Show & Hide
Objectives : At the end of this exercise you shall be able to:
•	 versatility, unique features
•	 open-source, Idynami brushes.

Tools/Materials
•	  PC/Laptop with windows		
•	  3D Printing, Modeling	

Requirements

Procedure
Objective
The primary objective of integrating a cloth draping exercise into the curriculum is to equip students with 
comprehensive skills in manipulating  fabric and understanding its behaviour 

when draped over a form. This exercise specifically targets the mastery of  single draping techniques, emphasizing 
the symbiotic relationship between  cloth and form in fashion design. 

Materials required
1	 Diverse selection of cloth pieces encompassing various textures,  weights, and draping properties. 

2	 Mannequins or dress forms to serve as the foundational structures for  draping. 

3	 Essential draping tools including pins, scissors, and measuring tape to  facilitate the manipulation of fabric. 

4	 Optional: Additional tools such as fabric weights or rulers for advanced  draping techniques. 

1	 Place cloth
 - 	 Begin by instructing students to meticulously select an appropriate fabric  based on the desired aesthetic, 

functionality, and design concept. 

 - 	 Guide them in placing the chosen fabric onto the designated mannequin or  dress form, ensuring a smooth 
and even surface for draping.

2	 Clear cloth
 - 	 Prioritize the elimination of any wrinkles, folds, or imperfections present in  the fabric that may impede the 

draping process. 

 - 	 Emphasize the importance of meticulous preparation in achieving optimal  draping results. 

3	 Single draping
 - 	 Provide comprehensive demonstrations and instructions on the intricacies  of single draping techniques, 

focusing on specific areas such as the bodice,  skirt, sleeves, or other design elements as per the curriculum 
requirements. 

 - 	 Encourage students to experiment with various draping methods including  pinning, folding, gathering, and 
pleating to sculpt the fabric into desired shapes  and silhouettes. 
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4	 Show & hide
 - 	 Encourage students to explore the creative possibilities of revealing and  concealing different aspects of 

the underlying form through strategic draping. 

 - 	 Foster an environment conducive to experimentation and innovation,  where students can push the 
boundaries of conventional draping techniques  to achieve unique and visually captivating compositions. 

Key points to note
- 	 Fabric Selection: Stress the significance of thoughtful fabric selection in  achieving desired draping outcomes, 

highlighting the diverse characteristics  and behaviors exhibited by different types of fabric. 

- 	 Understanding Form: Foster a deep understanding of the underlying form and  its impact on the draping 
process, empowering students to leverage form to  enhance the overall aesthetic and functionality of their 
designs. 

- 	 Precision and Creativity: Strike a balance between precision and creativity,  encouraging students to exercise 
precision in execution while embracing  creative freedom to explore innovative draping solutions. 

- 	 Practice and Patience: Emphasize the iterative nature of mastering draping  skills, emphasizing the importance 
of consistent practice, perseverance, and a  willingness to learn from both successes and setbacks.

Conclusion
The cloth draping exercise serves as a cornerstone in the development of  students’ proficiency in fashion design, 
providing them with invaluable hands on experience in manipulating fabric to bring their creative visions to life.  
Through dedicated practice and guidance, students can cultivate a nuanced  understanding of draping techniques, 
laying a solid foundation for their future  endeavors in the dynamic field of fashion design.

Stitch Property and 3D Property
Objectives : At the end of this exercise you shall be able to:
•	 versatility, unique features
•	 open-source, Idynami brushes.

Tools/Materials
•	  PC/Laptop with windows		
•	  3D Printing, Modeling	

Requirements

Procedure
1	 Introduction to stitch property

 - 	 Define stitch property as the characteristics of individual stitches  in fabric construction. 
 - 	 Discuss the significance of stitch properties in garment  construction and textile design. 

2	 Exploration of stitch properties
 - 	 Identify and examine different types of stitch properties such as  tension, density, elasticity, and formation. 
 - 	 Conduct practical exercises to demonstrate the impact of each  stitch property on fabric appearance, 

strength, and stretch. 
3	 Hands-on practice

 - 	 Provide hands-on experience with various stitching techniques,  adjusting stitch properties to achieve 
desired outcomes. 

 - 	 Encourage experimentation with different fabrics to observe how  stitch properties vary with material type 
and construction. 
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4	 Introduction to 3D property
 - 	 Define 3D property in textiles as the three-dimensional  characteristics of a fabric or textile product. 
 - 	 Discuss the key aspects of 3D property including thickness,  texture, flexibility, and drape.

5	 Exploration of 3D properties
 - 	 Examine different fabrics and textile products to analyze their 3D  properties. 
 - 	 Conduct experiments to measure and compare the thickness,  texture, flexibility, and drape of various 

fabrics. 
6	 Integration of stitch and 3D properties

 - 	 Explore the interrelation between stitch and 3D properties,  demonstrating how stitching techniques 
influence fabric  characteristics. 

 - 	 Discuss the importance of considering both properties in garment  design and textile product development. 

Conclusion: Understanding stitch property and 3D property is essential for textile  professionals involved in 
garment construction, textile design, and  product development. Through hands-on exploration and practical  
exercises, students gain valuable insights into the characteristics of  stitches and fabrics. Mastery of stitch 
properties allows for precise  control over fabric appearance, strength, and stretch, while an  understanding of 
3D properties enables designers to create garments  with optimal texture, drape, and functionality. By integrating  
knowledge of stitch and 3D properties, textile professionals can  produce high-quality products that meet aesthetic, 
functional, and  performance requirements. Continued learning and experimentation  are crucial for staying 
abreast of advancements in textile technology  and materials, ensuring ongoing innovation and excellence in the  
field of textiles.
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